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WELCOME TO PRINT AUDIT 4! 
 
The latest software from Print Audit offers tons of new features, and improvements on 
many of the standard ones. We took into account all the feedback we received since the 
release of Print Audit Enterprise, and with Print Audit 4, we have created the best print 
tracking and management solution on the market.  
 

WHAT'S NEW IN PRINT AUDIT 4? 
 
Print Audit 4 is our most comprehensive application to date. You will find a list of some 
of the major features added to Print Audit 4. Please read the help for the Client, Viewer 
and Administration application to get full details on all of the new features. 
 
 
NEW FEATURES 

� Print Audit 4 allows users to cancel print jobs. 
� Using Print Audit 4, you can set printers to track cost in one of two units: pages or 

square feet. 
� Print Audit now tracks paper size automatically. 
� Print Audit 4 can tell whether a job was printed in color or in black and white. 
� With Print Audit 4, you can require a user to enter a unique PIN code before 

printing a job. 
� User quotas allow you to assign users a dollar value. Print Audit 4 will keep a 

running balance of a user’s account – when it reaches zero, printing will be 
denied. 

� Print Audit 4’s centralized printer management means you can use Printer 
Configurations to assign different pricing and tracking options to different printers 
– quickly and easily! 

� Print Audit 4 lets you enter specific cost modifiers for different types of paper. 
� With Print Audit 4, you can rename the validated field to something perfectly 

suited to your business. 
� Now you can secure the Administration application so that only designated users 

can change Administration settings. 
� Print Audit 4, lets you set Viewer security to allow users to view their own data, 

no data or all data. 
� Print Audit 4’s fully flexible, intelligent defaulting system allows you to setup a 

system as simple or as complex as your own company’s printing structure. 
� A flexible exporting system built into the Viewer allows you to setup exports in 

Print Audit 4 for use with almost any program. 
� Print Audit 4 has accounting ability built into the Viewer! Now you can ensure 

that all jobs are accounted for once, and only once. 
� Print Audit 4 has fully integrated, "What’s This?", context-sensitive help in all 

applications. 
� Our easy-to-use WIZARD gets you started using Print Audit faster than ever! 

 

Technical support can be obtained via the following: 
• Our web site http://www.printaudit.com or E-mail: support@printaudit.com 
• Telephone toll free in North America 877 41 AUDIT (28348) or outside of North America 403 685-4932 (Canada) 

Page 1 



 

NOTES FOR UPGRADERS 
Below are a few things that you should be aware of when upgrading. 
 

� Some of the client desktop settings have been re-named or removed. Please 
review the new settings closely to ensure the client behaves the way you want it 
to. For example, the Connection Saver function has been removed: the client now 
functions in connection saver mode by default. 

� Print Audit 4 and Print Audit Enterprise can co-exist on the same machine. 
HOWEVER, you cannot (or at least, should not) run both versions of the client on 
the same machine at once. 

� All costs are now entered in dollars and cents. Print Audit Enterprise used cents 
only. 

� You cannot bring your old jobs into the new database. Print Audit 4 records many 
new pieces of information for print jobs, and the old print job records from Print 
Audit Enterprise are simply not compatible. If you still need access to those old 
records and have not exported them to some other application, we recommend 
you keep the Print Audit Enterprise Viewer and the old database around. 

� “Clients” in Print Audit Enterprise are equivalent to the Validated Field Values in 
Print Audit 4. This change was made to allow you the flexibility to name the 
validated field whatever you want to call it. If you like, you can just name the 
validated field, "Clients", and everything will work the same. 

� To bring your Print Audit Enterprise Clients into the new database, simply run the 
export from the Print Audit Enterprise Administration utility to put them in a 
comma-delimited file, and then use the Validated Values Import in the Print Audit 
4 Administration utility to bring them into the new one. 

� There is no "dump to cumulative file" option any more. To get a flat file for 
accounting purposes, use the Accounting Export in the Viewer. 

� The Data Dump utility and the Account Dump utility, which were separate 
programs in Print Audit Enterprise, have had their functionality incorporated into 
the Print Audit 4 Viewer. 

� The Maintain Database utility distributed with Print Audit Enterprise does not 
exist in Print Audit 4. Instead, if you need to compact the database, use the 
Microsoft Jet Compact utility we included with the install.  

Technical support can be obtained via the following: 
• Our web site http://www.printaudit.com or E-mail: support@printaudit.com 
• Telephone toll free in North America 877 41 AUDIT (28348) or outside of North America 403 685-4932 (Canada) 
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PRINT AUDIT 4 INSTALLATION INSTRUCTIONS 
 
How To Install 
1.  Close all open applications. 
2.  Insert the Print Audit CD into your CD-ROM drive. 
3. The Print Audit 4 installation program should start automatically.  If it does not, 
proceed to step 4. 
4.  Select "Run" from the windows Start menu. 
5.  Type "x:\setup.exe" in the Run window, where "x" equals the CD-ROM drive letter. 
6.  Click the OK button on the Run window. The set up should now start. 
 
At some point in the installation process, the set up program might indicate you need to 
restart the computer. Print Audit needs to do this so it can run properly. Click "OK" to 
reboot the computer. When the computer restarts, the installation process should start 
from where it left off. If not, you need to restart the set up yourself. 
 
When the installation is finished, you will notice a new entry in your Start Menu called 
Print Audit 4. The Print Audit Client should run automatically when the computer 
restarts.  
 
Installation Components 
There are several different components you can choose for installation. Below is each 
component, and the files it installs. 
 
 
 
Print Audit Client 
psapi.dll    SYSTEM(Only installed on NT) 
pa4clint.exe    INSTALL\client 
pa4popup.dll    INSTALL\client 
pa4wtrak.dll    INSTALL\client 
paclient40.hlp    INSTALL\help 
 
 
 
Viewer 
pa4view.exe    INSTALL\viewer 
pa4view.hlp    INSTALL\help 
 
 
 
 

Technical support can be obtained via the following: 
• Our web site http://www.printaudit.com or E-mail: support@printaudit.com 
• Telephone toll free in North America 877 41 AUDIT (28348) or outside of North America 403 685-4932 (Canada) 
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Administration 
pa4admin.exe    INSTALL\admin 
pa4admin40.hlp   INSTALL\help 
pa4wizrd.exe    INSTALL\admin 
pa4wizrd.hlp    INSTALL\help 
pa4cmpct.exe    INSTALL\admin 
 
 
 
Database 
pa4db.mdw    USER DEFINED 
 
 
 
Microsoft ADO 2.1 
This installs both dcom95.exe and mdac_typ.exe, as needed. For a full listing of the files 
installed with these executables, please see Microsoft's website. In some cases, a machine 
may have partial ADO installed. In this case, Print Audit 4 will detect the partial install 
and not re-install ADO. Print Audit 4 might not work with a partial install. If it does not 
work, run the mdac_typ.exe file directly from the install CD.  
 
Print Audit 4 will install Jet40Sp3_Comp.exe if needed. This contains the Microsoft Jet 
components for accessing the Microsoft Access database. These are installed 
automatically by the ADO 2.1 install, but if your system has ADO 2.6 or above installed 
Print Audit may need to install the Jet components separately. 
  
 
 
Always Installed 
The following files are always installed if either the Client, Administration tool or Viewer 
are installed. 
 
oleaut32.dll  2.40.4277 SYSTEM 
olepro32.dll  5.0.4277 SYSTEM 
asycfilt.dll  2.40.4277 SYSTEM 
stdole2.tlb  2.40.4277 SYSTEM 
msvbvm60.dll  6.00.8877 SYSTEM 
comcat.dll  4.71  SYSTEM 
mscomctl.ocx  6.00.8862 SYSTEM 
mscomct2.ocx  6.00.8804 SYSTEM 
vsflex7.ocx  7.0.0.131 SYSTEM 
vsview6.ocx  6.0.0.61 SYSTEM 
roboex32.dll  8.00.133 SYSTEM 
pa4data.dll   INSTALL\common 
 

Technical support can be obtained via the following: 
• Our web site http://www.printaudit.com or E-mail: support@printaudit.com 
• Telephone toll free in North America 877 41 AUDIT (28348) or outside of North America 403 685-4932 (Canada) 
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Microstation Plug-in 
If Print Audit detects that Bentley's Microstation/J is installed on your system, Print 
Audit installs the following files. 
 
paudit.ma   INSTALL\client\plugins\microJ 
pa4mtrak.dll   INSTALL\client\plugins\microJ 
pa4plug.cfg   BENTLYINSTALL 
\Program\Microstation\config\appl 
 
Database Selection 
The first time you run one of the Print Audit applications on a desktop, the program 
requires you to select a database. Select the database you installed during the installation. 
This database must be in a read/write directory that everyone who is going to use print 
audit can use. Once you select a database, and anytime you change the database on a 
desktop, it is selected or changed for the entire desktop. Print Audit stores the database 
setting in: 
HKEY_CURRENT_USER\Software\Print Audit 4.0\Database. 
 
 
How To Un-Install 

1. Open the computer's Control Panel. 
2. Double-click on Add/Remove programs. 
3. Locate Print Audit 4.0 in the list of installed applications. 
4. Click on it to select it. If selected, it will be highlighted. 
5. Click the Add/Remove button to remove Print Audit 4.0. 

 
Once removed, you will have to re-install if you want to use Print Audit 4. 

Technical support can be obtained via the following: 
• Our web site http://www.printaudit.com or E-mail: support@printaudit.com 
• Telephone toll free in North America 877 41 AUDIT (28348) or outside of North America 403 685-4932 (Canada) 
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PRINT AUDIT 4 ADMINISTRATION OVERVIEW 
 
 
The Print Audit Administration program allows advanced configuration of Print Audit 4. 
For simple installations of Print Audit 4, you may not need to use the Administration 
utility often, but you should familiarize yourself with all aspects of the program. 

 
 
Popup Window Settings Tab 

 
This tab allows you to configure how the Print Audit 4 Client behaves on the user’s 
desktop. Changes you make here may not take affect until the user reboots their machine 
or restarts Print Audit. These changes affect all users connected to the database. 
The tab is divided into four main sections: 
 
 
Validation Settings 
This section determines how Print Audit 4 will force validation on the popup. If a user 
does not enter valid information, the job cannot continue. There are three ways for a user 
to validate a job: 
Require user to enter a PIN code – This setting determines whether or not a user must 
enter a PIN code on the popup window in order to print the job. These PIN codes 
correspond to the PIN codes of the Print Audit users. (For more information on PIN 
codes and users, see Table of Contents: Print Audit 4 Administration Overview: User 
Overview.) 
Use Validation – This setting determines whether or not a user must enter a valid value 
on the popup window. You can name this value whatever you want in the next field. 
Validation Name – You can enter a name for the validated value in this field. For 
backwards compatibility with previous versions of Print Audit, this would be “Popup”. 
You can, however, use whatever name is most appropriate for your business, such as 
“Project” or “Account”. 
 
 

Technical support can be obtained via the following: 
• Our web site http://www.printaudit.com or E-mail: support@printaudit.com 
• Telephone toll free in North America 877 41 AUDIT (28348) or outside of North America 403 685-4932 (Canada) 
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General Settings 
This section contains several check boxes that control general behaviour of the Print 
Audit Popup. 
Allow client shutdown – This setting determines whether or not the user can shut down 
the Print Audit Client. This requires you to check Display Tray Icon as well. If both are 
checked, the user can shut down the client by double clicking on the icon with the right 
mouse button. 
Display tray icon – This setting determines whether or not the Print Audit icon displays 
in the user’s system tray when Print Audit runs. You can use this icon to shut down Print 
Audit and as a visual check to ensure it is running. 
Show unit cost – This setting determines whether or not the cost per unit of the current 
print job displays on the popup. 
Allow user to override cost – This setting determines whether or not users can enter 
their own cost per unit for the current print job. This setting requires you to check Show 
unit cost. 
Stop job on max page - This setting determines whether or not Print Audit 4 stops the 
print job if it exceeds a maximum page value. If not, Print Audit still displays a “max 
page” message to the user. (For more information on maximum page limits, see Table of 
Contents: Print Audit 4 Administration Overview: Printer Management Overview.) 
Use last job entries – This setting determines whether or not Print Audit 4 automatically 
populates values on the popup with the values used for the last job. The only affected 
fields on the popup are the validated value field and the two user-defined fields, as the 
others can change depending on the printer. 
Track print to file – This setting determines whether or not Print Audit 4 tracks jobs 
when the user prints to file from an application. If checked, Print Audit treats these types 
of jobs as if they were printed to the printer. If cleared, Print Audit ignores these types of 
jobs. 
 
 
Batch Settings 
This section covers the batching functionality of the Print Audit Client. With batching the 
user can enter the number of jobs in the batch on the Print Audit popup window. Print 
Audit 4 then automatically reuses those settings without popping the window up again. 
This can be useful in situations where a program breaks its printing into several Windows 
print jobs. Print Audit automatically cancels a batch if the print job comes from a 
different application, or gets printed to a different printer. 
Allow job batching – This setting determines whether or not batching is turned on in the 
Print Audit client. 
Max batch size – This setting puts a limit on the number of jobs a user can include in a 
batch. 
Batch duration - This setting determines how long a batch can "idle". Basically if the 
specified number of minutes passes between jobs in a batch, Print Audit automatically 
cancels the batch. 
 

Technical support can be obtained via the following: 
• Our web site http://www.printaudit.com or E-mail: support@printaudit.com 
• Telephone toll free in North America 877 41 AUDIT (28348) or outside of North America 403 685-4932 (Canada) 
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User-Defined Fields 
This section contains the settings for the user-defined fields. You can have two free-form 
entry fields appear on the popup. You can name these fields whatever makes sense for 
your business. These fields are not validated. Changing the names for the fields also 
changes the names of the columns returned in the Print Audit Viewer. 
Field1 – Here you enter your custom name for the first user-defined field. 
Field2 – Here you enter your custom name for the second user-defined field. 
Show on client – This checkbox turns the user-defined fields on or off. To preserve data 
integrity, any information previously entered for these fields remains in the Print Audit 
database, along with your current names for the fields. 
 

 
 

Users and Security Tab 

 
This tab allows you to search for, add, edit and delete Print Audit 4 users. If you do not 
need any type of security for entering print jobs or for using the different Print Audit 
tools, you do not need to do anything on this tab. (For more information on Print Audit 
users, see Table of Contents: Print Audit 4 Administration Overview: User Overview.) 
 
To Change Application Security: 
1 Click the Administration requires PIN code checkbox to require a PIN code to enter 
the Administration tool. A user must have Administrator privileges to then be able to use 
the Administration tool. If the checkbox is clear, anyone can use the Administration tool. 
OR 
1 Click the Viewer requires PIN code checkbox to require a PIN code to enter the 
Viewer tool. A user must have some level of Viewer privileges to be able to use the 
Viewer tool. 
(For more information on users and security levels, see Table of Contents: Print Audit 4 
Administration Overview: User Overview.). 
 

Technical support can be obtained via the following: 
• Our web site http://www.printaudit.com or E-mail: support@printaudit.com 
• Telephone toll free in North America 877 41 AUDIT (28348) or outside of North America 403 685-4932 (Canada) 
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To add users: 
1 Click the Add button.  The User Edit window appears. 
2 Enter the information for the new user. Click here for more information on the User 
Edit window. 
3 Click the Add button on the User Edit window. Print Audit saves the information and 
clears the window. 
4 Repeat steps 2 and 3 for as many users as you want to add. 
5 Click the Close button on the User Edit window to close the window. The list of users 
refreshes. 
  
To Edit Users: 
1 Type the partial or full name of the user you want to find in the Search text box. The 
list of matching users displays in the grid below. 
2 Click on the row that corresponds to the user you want to edit. 
OR 
2 Use standard Windows CTRL and SHIFT clicking procedures to select multiple users. 
Selected rows are highlighted. 
3 Click the Edit button. The User edit window appears. Some fields appear gray as you 
can only edit some values for multiple users at once. If the value you want to change is 
grayed you must edit the user singularly. 
4 Make the changes you want to make. Click here for more information on the User Edit 
window. 
5 Click the Save button on the User Edit window. The window closes and the changes 
show in the grid. 
 
To Delete Users: 
1 Type the partial or full name of the user you want to find in the Search text box. The 
list of matching users display in the grid below. 
2 Click on the row that corresponds to the user you want to delete. 
OR 
2 Use standard Windows CTRL and SHIFT clicking procedures to select multiple users. 
Selected rows are highlighted. 
3 Click the Delete button. A message box appears to confirm that you want to delete the 
users. 
4 Click the Yes button on the message box to delete the users. Print Audit deletes the 
users. 
NOTE: You cannot delete users that have jobs in the database. You must also always 
have one Administrator user. 
 

 
 

Technical support can be obtained via the following: 
• Our web site http://www.printaudit.com or E-mail: support@printaudit.com 
• Telephone toll free in North America 877 41 AUDIT (28348) or outside of North America 403 685-4932 (Canada) 
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User Edit Window 

 
This window allows you to add or edit Print Audit 4 users. A description of each of the 
fields follows. (For more information on Print Audit users, see Table of Contents: Print 
Audit 4 Administration Overview: User Overview.). 
PIN code – This field contains the PIN code of the user. These codes are deliberately 
obscured when loaded as an extra security measure. You must enter a unique PIN code 
for each user. 
Name – This field contains the name of the user. This name displays in all reporting and 
displays, so ensure it is meaningful. You must enter a name for each user. 
User quotas – Check this box to turn on quotas for this user. (For more information on 
quotas, see Table of Contents: Print Audit 4 Administration Overview: User Overview.) 
Quota amount – This field contains the amount remaining in the quota. If zero or less 
than zero, the user can no longer print. This value can be less than zero in some cases 
when a quota is exceeded while printing multiple copies. 
Administrator – Check this box to allow this user to use the Administration utility. This 
setting is effective only if the Administration requires PIN code box on the Users and 
Security Tab is checked. 
Viewer Rights – Click on this combo box to select the Viewer security for this user. This 
setting is effective only if the Viewer requires PIN code box on the Users and Security 
Tab is checked. The three possible values are: 
None – The user cannot use the Viewer. 
Own Data – The user can use the viewer, but can only see their own data. 
All Data – The user can use the viewer and has access to all users data. 
 
Previous Button – Click this button to move backwards through the list of users you 
added. This list of users is only valid until you close the window.  This button is only 
available while adding users. 
Next Button – Click this button to change or move forward through the list of users you 
added. Once you hit the end of the list the window is blank, and you can add another 
user. The list of users is only valid until you close the window. This button is only 
available while adding users. 
Save/Add Button – Click this button to save changes to the user. If adding, the user the 
button will read Add, otherwise it will read Save. 
Technical support can be obtained via the following: 

• Our web site http://www.printaudit.com or E-mail: support@printaudit.com 
• Telephone toll free in North America 877 41 AUDIT (28348) or outside of North America 403 685-4932 (Canada) 
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Cancel/Close Button – Click this window to cancel changes to the user, or to close the 
window and continue. 
 
 
Validated Values Tab 

 
This tab allows you to search for, add, edit and delete values for your validated field. The 
name of this field depends on the settings on the Popup Window Settings Tab. If you do 
not want to use validated values on the client popup, you do not have to do anything with 
this tab. You must check the Use Validated checkbox on the Popup Window Settings 
Tab to enforce the validation. (For more information on how Print Audit uses the 
Validated Values, see Table of Contents: Print Audit 4 Administration Overview: Custom 
Fields Overview.) 
 
To Add Values: 
1 Click the Add button.  The Value Edit window appears. 
2 Enter the information for the new value. Click here for more information on the Value 
Edit window. 
3 Click the Add button on the Value Edit window. Print Audit saves the information 
and clears the window. 
4 Repeat steps 2 and 3 for as many users as you want to add. 
5 Click the Close button on the User Edit window to close the window. The list of users 
refreshes. 
 
To Edit Values: 
1 Type the partial or full code of the value you want to find in the Search text box. The 
list of matching values displays in the grid below. You can click either Code or 
Description, depending on which type of search you want. 
2 Click on the row that corresponds to the value you want to edit. 
OR 
2 Use standard Windows CTRL and SHIFT clicking procedures to select multiple 
values. Selected rows are highlighted. 

Technical support can be obtained via the following: 
• Our web site http://www.printaudit.com or E-mail: support@printaudit.com 
• Telephone toll free in North America 877 41 AUDIT (28348) or outside of North America 403 685-4932 (Canada) 

Page 11 



 

3 Click the Edit button. The Value Edit window appears. Some fields appear gray as 
you can only edit some fields for multiple values at once. If the field you want to change 
is grayed you must edit the value singularly. 
4 Make the changes you want to make. Click here for more information on the Value 
Edit Window. 
5 Click the Save button on the Value Edit window. The window closes and the changes 
show in the grid. 
 
To Delete Values: 
1 Type the partial or full code of the value you want to find in the Search text box. The 
list of matching values displays in the grid below. You can click either Code or 
Description depending on which type of search you want. 
2 Click on the row that corresponds to the value you want to delete. 
OR 
2 Use standard Windows CTRL and SHIFT clicking procedures to select multiple 
values. Selected rows are highlighted. 
3 Click the Delete button. A message box appears to confirm that you want to delete the 
values. 
4 Click the Yes button on the message box to delete the values. Print Audit deletes the 
values. 
 
To Import Values From a List: 
1 Click the Import button. A standard Windows open file dialog appears. 
2 Use the dialog to select a comma-delimited file containing the values you want to 
import. 
3 Click the Open button. The open dialog closes, and Print Audit 4 starts importing the 
values. 
Print Audit 4 displays any errors after the import completes. NOTE: The format of the 
comma-delimited file must be: 
Code, Description, Cost Modifier, Active. Please keep in mind that the code must be 
unique across all values. 
 
To Export Values to a List: 
1 Click the Export button. A standard Windows save dialog appears. 
2 Use the dialog to choose the name of the file you want to export to. 
3 Click the Save button on the dialog. Print Audit starts exporting the values to a comma-
delimited file. 
 

Technical support can be obtained via the following: 
• Our web site http://www.printaudit.com or E-mail: support@printaudit.com 
• Telephone toll free in North America 877 41 AUDIT (28348) or outside of North America 403 685-4932 (Canada) 
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Value Edit Window 

 
This window allows you to edit and add values for the validated field. A description of 
each of the buttons and fields follows. (For more information on Validated Values and 
how Print Audit 4 uses them see Table of Contents: Print Audit 4 Administration 
Overview: Custom Fields Overview.) 
. 
Code – This field contains the code for the value. This code must be unique. 
Description – This field contains the description of the value. This description can be 
anything. 
Active – This checkbox determines whether or not the value is active. If not active the 
user cannot select it on the Print Audit Popup window. 
Cost Modifier – This contains the cost modifier percentage for the value. You use this to 
dynamically adjust the base cost of the current print job. For example, you could have a 
value with a code of ‘9999’ that corresponds to an internal account for zero cost printing. 
You would then specify that the value has a cost modifier of 0%, which means every job 
with this value has 0% of the final job cost. You define the base cost of a job in the 
Printer Configuration. 
Previous Button – Click this button to move backwards through the list of values you 
added. This list of values is only valid until you close the window.  This button is only 
available while adding values. 
Next Button – Click this button to change or move forward through the list of values you 
have added. Once you hit the end of the list, the window is blank and you can add another 
value. The list of values is only valid until you close the window. This button is only 
available while adding values. 
Save/Add Button – Click this button to save changes to the value. If adding, the value, 
the button will read Add, otherwise it will read Save. 
Cancel/Close Button – Click this window to cancel changes to the value, or to close the 
window and continue. 
 
 

Technical support can be obtained via the following: 
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Paper Types Tab 

 
This tab allows you to add, edit and delete paper types from the database. If you do not 
want to charge different prices for different types of paper, you do not need to use this 
tab. For more information on how Print Audit uses Paper Types, see Table of Contents: 
Print Audit 4 Administration Overview: Paper Types Overview.) 
 
To Add Paper Types: 
1 Click the Add button.  The Paper Type Edit window appears. 
2 Enter the information for the new paper type. Click here for more information on the 
Paper Type Edit window. 
3 Click the Add button on the Paper Type Edit window. Print Audit saves the 
information and clears the window. 
4 Repeat steps 2 and 3 for as many paper types as you want to add. 
5 Click the Close button on the Paper Type Edit window to close the window. The list of 
paper types refreshes. 
 
To Edit Paper Types: 
1 Click on the row that corresponds to the paper type you want to edit. 
2 Click the Edit button. The Paper Type Edit window appears.  
3 Make the changes you want to make. Click here for more information on the Paper 
Type Edit Window. 
4 Click the Save button on the Paper Type Edit window. The window closes and the 
changes show in the grid. 
 
To Delete Paper Types: 
1 Click on the row that corresponds to the paper type you want to delete. 
OR 
1 Use standard Windows CTRL and SHIFT clicking procedures to select multiple 
values. Selected rows are highlighted. 
2 Click the Delete button. A message box appears to confirm that you want to delete the 
paper types. 
3 Click the Yes button on the message box to delete the paper types. Print Audit deletes 
the paper types. 
Technical support can be obtained via the following: 

• Our web site http://www.printaudit.com or E-mail: support@printaudit.com 
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To Change the Display Order: 
1 Click on the row that corresponds to the paper type for which you want to change the 
display order. 
2 Click the Move Up or Move Down button. The paper type moves up or down in the 
list. 
The order the paper types are in corresponds to the order in which they display to the user 
on the Print Audit Popup window. 
 
 
Paper Type Edit Window 

 
This window allows you to edit and add paper types. Print Audit uses these paper types 
for the Print Audit Configurations. (For more information on paper types, see Table of 
Contents: Print Audit 4 Administration Overview: Paper Types Overview) 
 
Description – This field contains the description of the paper type. Examples of this 
might be Film, or Vellum. 
Cost Modifier – This contains the cost modifier percentage for the paper type. You use 
this to dynamically adjust the base cost of the current print job. For example, you could 
have a Vellum paper type that you want to charge double the normal printing cost for.  In 
this case, you would enter 200% for the cost modifier. You define the base cost for a job 
in the Printer Configuration. 
Active - This check determines whether or not the paper type is active. If not, it does not 
appear in any lists. 
Default – This check determines if the paper type is the default paper type used. You can 
have only one default. 
Previous Button – Click this button to move backwards through the list of paper types 
you added. This list of types is only valid until you close the window.  This button is only 
available while adding paper types. 
Next Button – Click this button to change or move forward through the list of paper 
types you added. Once you hit the end of the list the window is blank and you can add 
Technical support can be obtained via the following: 
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another type. The list of types is only valid until you close the window. This button is 
only available while adding paper types. 
Save/Add Button – Click this button to save changes to the paper type. If adding the 
paper type, the button will read Add, otherwise it will read Save. 
Cancel/Close Button – Click this window to cancel changes to the paper type, or to close 
the window and continue. 
 
 
Printer Configurations Tab 

 
This tab allows you to add, edit and delete printer configurations. Print Audit 
automatically creates one configuration for you. If you do not need different pricing 
configurations for different printers, you do not need to use this tab. (For more 
information on how Print Audit 4 uses these configurations, see Table of Contents: Print 
Audit 4 Administration overview: Printer Management Overview). 
 
 
To Add Printer Configurations: 
1 Click the Add button.  The Printer Configuration Edit window appears. 
2 Enter the information for the new printer configuration. Click here for more 
information on the Printer Configuration Edit window. 
3 Click the Add button on the Printer Configuration Edit window. Print Audit saves the 
information and clears the window  
4 Repeat steps 2 and 3 for as many printer configurations as you want to add. 
5 Click the Close button on the Printer Configuration Edit window to close the window. 
The list of configurations refreshes. 
 
To Edit Printer Configurations: 
1 Click on the row that corresponds to the configuration you want to edit. 
2 Click the Edit button. The Printer Configuration Edit window appears.  
3 Make the changes you want to make. Click here for more information on the Printer 
Configuration Edit Window. 
4 Click the Save button on the Printer Configuration Edit window. The window closes 
and the changes show in the grid. 
Technical support can be obtained via the following: 
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To Delete Printer Configurations: 
1 Click on the row that corresponds to the printer configuration you want to delete. 
OR 
1 Use standard Windows CTRL and SHIFT clicking procedures to select multiple 
configurations. Selected rows are highlighted. 
2 Click the Delete button. A message box appears to confirm that you want to delete the 
configurations. 
3 Click the Yes button on the message box to delete the configurations. Print Audit 
deletes the configurations. 
NOTE: You cannot delete printer configurations that are assigned to printers. 
 
 
Printer Configuration Edit Window 

 
This window allows you to edit and add printer configurations. You can then assign these 
configurations to specific printers. For more information on how Print Audit uses printer 
configurations, see Table of Contents: Print Audit 4 Administration Overview: Printer 
Management Overview) 
 
Name – This field contains the name of the configuration. This name should be unique. 
Tracking Option – There are three options for tracking jobs in a printer configuration. 
They are: 
Show Popup – The Print Audit 4 popup window appears so the user can enter 
information. 
Track with no popup – The job is tracked with default information. Note that several 
values will be set to "unknown" in the database. 
Do not track – Specifies that you are not interested in jobs being printed to this 
configuration. 
Unit – Use this drop down box to select the units for the job. Your choices are Pages and 
Square Feet. Print Audit calculates the square footage based on the paper size used when 
printing the job. 
Max Pages – This field contains the maximum number of pages per job for this 
configuration. Depending on the Stop Job on Max Page setting in the Popup Window 
Technical support can be obtained via the following: 
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Settings, the job will stop printing after this many pages. If you do not want to use max 
pages, leave this field blank. 
Max Error – This box contains the error message that Print Audit displays to the user 
when they exceed the maximum number of pages. If you leave this box blank, Print 
Audit displays a default message. The message is limited to 255 characters. To put in a 
carriage return, hold down CTRL and hit ENTER. 
Cost – This field contains the base cost per unit for the configuration. 
Color Modifier – This field allows you to enter a percentage cost modifier for color jobs. 
If you want to charge double for color jobs for this configuration, you would enter 200. 
Paper Types – This table contains a list of all active paper types in the database. To use 
this paper type for the configuration, check the Use column for that paper type. You can 
also override the Cost Modifier for each paper type for the configuration. You do not 
have to specify paper types for a configuration. 
Previous Button – Click this button to move backwards through the list of 
configurations you added. This list of configurations is only valid until you close the 
window.  This button is only available while adding configurations. 
Next Button – Click this button to change to move forward through the list of 
configurations you added. Once you hit the end of the list the window is blank and you 
can add another configuration. The list of configurations is only valid until you close the 
window. This button is only available while adding configurations. 
Save/Add Button – Click this button to save changes to the configuration. If adding the 
configuration the button will read Add, otherwise it will read Save. 
Cancel/Close Button – Click this window to cancel changes to the configuration, or to 
close the window and continue. 
 
 
Printers Tab 

 
This tab allows you to add, edit and delete printers. You also use this tab to set the default 
printer configuration. If you do not need to have different pricing structures or printing 
behaviour for different printers in your organization then you do not need to use this tab. 
(For more information on how Print Audit 4 uses printers see Table of Contents: Print 
Audit 4 Administration Overview: Printer Management Overview). 
 
Technical support can be obtained via the following: 
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To Change the Default Configuration: 
1 Click on the Default Configuration drop down box at the top of the tab. A list of 
entered printer configurations appears. Click here for information on Printer 
Configurations. 
2 Click the printer configuration you want to use. The configuration appears in the box 
and Print Audit saves the change. 
 
To Add Printers: 
1 Click the Add button.  The Printer Edit window appears. 
2 Enter the information for the new printer. Click here for more information on the 
Printer Edit window. 
3 Click the Add button on the Printer Edit window. Print Audit saves the information and 
clears the window. 
4 Repeat steps 2 and 3 for as many printers as you want to add. 
5 Click the Close button on the Printer Edit window to close the window. The list of 
printers refreshes. 
 
To Edit Printers: 
1 Click on the row which corresponds to the printer you want to edit. 
OR 
1 Use standard Windows CTRL and SHIFT clicking procedures to select multiple 
values. Selected rows are highlighted. 
2 Click the Edit button. The Printer Edit window appears. Some fields appear gray as 
you can only edit some fields for multiple printers at once. If the field you want to change 
is grayed you must edit the value singularly. 
3 Make the changes you want to make. Click here for more information on the Printer 
Edit Window. 
4 Click the Save button on the Printer Edit window. The window closes and the changes 
show in the grid. 
 
To Delete Printers: 
1 Click on the row which corresponds to the printer you want to delete. 
OR 
1 Use standard Windows CTRL and SHIFT clicking procedures to select multiple 
printers. Selected rows are highlighted. 
2 Click the Delete button. A message box appears to confirm that you want to delete the 
printers. 
3 Click the Yes button on the message box to delete the printers. Print Audit deletes the 
printers. 
 
 

Technical support can be obtained via the following: 
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Printer Edit Window 

 
Use this window to add and edit printers. You can also use this window to add new 
printer configurations, but not edit them. (For more information on how Print Audit uses 
printers, see Table of Contents: Print Audit 4 Administration Overview: Printer 
Management Overview). 
 
Name – This is the name of the printer. You choose this name. It should be meaningful 
for your business. For example, the name could include the type of printer, location of the 
printer, etc. 
Port – This field contains the port information for the printer. This is generally the UNC 
of the printer. This must be unique across printers. This may also be the model name of a 
printer when tracking plotting from CAD programs. (For more information on how this 
field works with CAD plotting, see Table of Contents: Print Audit 4 Administration 
Overview:  CAD Plot Tracking Overview.) 
Port Browse Button – Click this button to open a network-browsing dialog so you can 
search for the printer you want to add. Please note that depending on how you hooked the 
printer to the network, it may not show up in the window. In this case you can enter the 
port information directly into the Port field. To find the port name, use the Windows 
Printer properties. 
Configuration Name – This dropdown box contains the name of the configuration you 
want to use for this printer. You can select from any configuration you have previously 
created, or you can select the <New Configuration> option that allows you to enter a new 
configuration. 
Configuration Fields – The rest of the fields defining the configuration are the same as 
the fields on the Printer Configuration Edit window. You cannot change these fields if 
you chose a previously defined configuration in the Configuration Name field. 
Previous Button – Click this button to move backwards through the list of printers you 
have added. This list of configurations is only valid until you close the window.  This 
button is only available while adding printers. 
Next Button – Click this button to change to move forward through the list of printers 
you have added. Once you hit the end of the list the window is blank and you can add 
another printer. The list of printers is only valid until you close the window. This button 
is only available while adding printers. 
Technical support can be obtained via the following: 
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Save/Add Button – Click this button to save changes to the printer. If adding the printer 
the button will read Add, otherwise it will read Save. 
Cancel/Close Button – Click this window to cancel changes to the printer, or to close the 
window and continue. 
 
 
Applications Tab 

 
This tab allows you to add, edit and delete applications. Print Audit uses these 
applications to exclude or include jobs from being tracked. (For more information on how 
Print Audit uses applications, see Table of Contents: Print Audit 4 Administration 
Overview:  Application Tracking Overview.) 
 
To Set The Application Tracking Option: 
1 Click the Track only these applications checkbox. If checked, then Print Audit 
ignores printing from any application not in the list. If cleared, then Print Audit pops up 
for all applications not in the list, and uses the specific settings for apps in the list. 
 
To Add Applications: 
1 Click the Add button.  The Application Edit window appears. 
2 Enter the information for the application. Click here for more information on the 
Application Edit window. 
3 Click the Add button on the Application Edit window. Print Audit saves the 
information and clears the window. 
4 Repeat steps 2 and 3 for as many applications as you want to add. 
5 Click the Close button on the Application Edit window to close the window. The list of 
applications refreshes. 
 
To Edit Applications: 
1 Click on the row that corresponds to the application you want to edit. 
2 Click the Edit button. The Application Edit window appears.  
3 Make the changes you want to make. Click here for more information on the 
Application Edit Window. 

Technical support can be obtained via the following: 
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4 Click the Save button on the Application Edit window. The window closes and the 
changes show in the grid. 
 
To Delete Applications: 
1 Click on the row that corresponds to the application you want to delete. 
OR 
1 Use standard Windows CTRL and SHIFT clicking procedures to select multiple 
applications. Selected rows are highlighted. 
2 Click the Delete button. A message box appears to confirm that you want to delete the 
applications. 
3 Click the Yes button on the message box to delete the applications. Print Audit deletes 
the applications. 
 
Application Edit Window 

 
You use this window to add and edit Print Audit applications. (For more information on 
Print Audit Applications, see Table of Contents: Print Audit 4 Administration Overview:  
Application Tracking Overview.) 
 
Name – This is the file name of the executable for the application. You must include the 
extension for the file but DO NOT INCLUDE THE PATH. 
Name Browse Button – You can click this button to bring up a standard file-browsing 
dialog to find the file for the application you want to add. 
Description – This field contains a free format description of the application. You might 
want to enter a meaningful description of the file here. 
Track type – This combo box contains the track type options for applications. You can 
pick from three types: 
Track with popup – When printing from this application, the Popup window will 
appear. 
Track with no popup – Print Audit tracks the job, but no popup window appears. 
Do not track job – Print Audit ignores any jobs from this app. 
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Previous Button – Click this button to move backwards through the list of applications 
you have added. This list of applications is only valid until you close the window.  This 
button is only available while adding applications. 
Next Button – Click this button to change to move forward through the list of 
applications you added. Once you hit the end of the list, the window is blank and you can 
add another application. The list of applications is only valid until you close the window. 
This button is only available while adding applications. 
Save/Add Button – Click this button to save changes to the application. If adding the 
application the button will read Add, otherwise it will read Save. 
Cancel/Close Button – Click this window to cancel changes to the application, or to 
close the window and continue. 
 
User Overview 
Users in Print Audit serve three important functions: job validation, application security 
and quotas. A description of each of these follows. 
 
User Security  
You can require your users to enter a PIN code before a job will be printed. This type of 
security is ideal for educational institutions, real estate offices or other businesses with 
multiple users printing from one computer, who need to ensure that only authorized 
printing occurs. To activate user level job validation, use the Popup Window Settings 
Tab. To add and edit users, use the Users and Security Tab. (See Table of Contents: Print 
Audit 4 Administration Overview.) 
 
Application Security  
Print Audit now allows you to secure access to the Viewer and Administration 
applications on a user basis. This allows you to give administration privileges to users 
you want. The Viewer security allows you to give a user the ability to view their own 
data, no data, or all data present in the system. To add and edit users as well as activate 
the application security, see the Users and Security Tab and the User Edit window. (See 
Table of Contents: Print Audit 4 Administration Overview.) 
 
User Quotas  
You can now assign a quota to a user. This functionality is ideal in a "pay to print" 
situation when someone has purchased an amount of printing, or when you just want to 
control the amount of printing a user is doing. You can assign each user a quota. Then 
every time that user prints a job, Print Audit subtracts the cost of the job from their quota. 
Once they hit zero, they can no longer print. Job validation must also be enabled for this 
to work. To add and edit users and/or change their quota information, see the Users and 
Security Tab and the User Edit Window. (See Table of Contents: Print Audit 4 
Administration Overview.) 
 
 
Custom Fields Overview 
Print Audit allows you to define two types of custom fields, validated and non-validated. 
Validated means that Print Audit takes the value the user enters in the field and validates 
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it against values you enter into the database. If there is no match, the user cannot print the 
job. Non-validated fields are free form entry fields. 
You can enter your own names for the custom fields. You can have one validated custom 
field, and two non-validated custom fields. Print Audit simply calls the non-validated 
fields the "user-defined" fields. 
 
To activate the Validated field functionality – use the Popup Window Settings Tab.  
To add and edit values – use the Validated Values Tab and the Value Edit Window. 
To activate the User-defined fields – use the Popup Window Settings Tab. 
 
Paper Types Overview 
Print Audit allows you to define custom paper types in the database that you can then 
assign to printer configurations. These paper types give you further pricing control when 
printing jobs depending on the type of media the user is using for the job. For example, 
you may want to have different pricing for printing on regular bond paper then you would 
if they were printing to vellum or transparent film. 
 
To add and edit paper types – use the Paper Types Tab and the Paper Type Edit 
Window. 
 
Licensing Overview 
Print Audit enforces licensing through the use of a license key. You obtain this license 
key from Print Audit when you purchase the product. It is unlawful to distribute this 
license key to anyone not covered specifically in the license agreement. It is also 
unlawful to circumvent the licensing in any way. 
When you first download and install Print Audit with a new database, it defaults to a 
standard 15-day, five-user license. Once your 15 days are up, or when you want to 
purchase more users, contact Print Audit. 
Print Audit does allow you to specify how Print Audit will behave in case of a license 
violation. This allows you to carry on with your business until you purchase more 
licenses or otherwise resolve the conflict. 
 
To add/change the license key: 
1 Click the Options->Change Licensing menu option in the Administration program. 
The Licensing window appears. 
2 Enter the license key in the License field. 
3 Click the Do not track job option to have Print Audit allow the job to go through but 
not track the data in case of a license violation 
OR 
3 Click the Stop job from printing option to stop the job from printing in case of a 
license violation. 
 
Printing Costs Overview 
Print Audit calculates the final print job cost using five values: 
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Unit Type – This sets how you want to charge for the job, either per page or per square 
foot. You enter the type of tracking you want to do in the Printer Configuration. You can 
change configurations in the Print Audit Administration tool under the Printer 
Configurations tab. 
Cost Per Unit – This is the base cost for the job. You define this cost in the Print Audit 
Administration tool under the Printer Configurations tab. This cost can have up to 3 
decimal places. 
Color Modifier – This is a percentage used as a cost modifier if the job printed was a 
color job. You define this percentage in the Printer Configuration. You can change 
configurations in the Print Audit Administration tool, under the Printer Configurations 
tab. 
Paper Type Cost Modifier – This is a percentage used as a cost modifier if the user 
chooses a specific paper type. There are two places you can modify this percentage. You 
can enter the default cost modifier per paper type on the Paper Types tab in the Print 
Audit Administration tool or you can enter a cost modifier specifically for a 
configuration. You can change configurations in the Print Audit Administration tool 
under the Printer Configurations tab. 
Validated Value Cost Modifier – This is a percentage used as a cost modifier if the user 
enters a validated value on the Print Audit Client Popup Window. To use validated values 
you must check the Use Validation option under the Popup Window Settings tab in the 
Administration program. 
 
Square Footage 
Print Audit calculates square footage from the paper size used for the job. The final units 
for the job are calculated as:  
pages * copies * (paper width * paper height) 
 
Percentages 
If a percentage is above 100, then you are adding to the cost of the job. If it is below 100, 
then you are subtracting from the cost of the job. For example, if you enter a percentage 
modifier of 25%, then the job will cost one quarter of the final price. If you enter 0% for 
any modifier, the job will be free. All percentages are cumulative. This means that all 
cost percentages are calculated one after the other. Here are some examples of how 
pricing works: 
 
Example One 
Let’s assume that you are charging $1.00 per page for printing. You have specified a 
color job modifier of 200% (double), and the user enters a validated value that has a cost 
modifier of 25% (one quarter). In this example you are not using paper types. If the job 
had 20 pages and was printing in color, the final job cost after taking into account all of 
the modifiers would be: 
($1.00 * 20) * 2 * .25 = $10.00 
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Example Two 
In this example, let’s assume you are charging $5.00 per page for printing. You have a 
paper type called Scrap that has a cost modifier of 25%. The user enters a validated value 
that has a cost modifier of 75%. The job was printed in black and white, so no need to 
worry about any color modifier. If the job had 10 pages, the final job cost would be: 
($5.00 * 10) * .25 * .75 = $9.375 
Be careful, because at first look you might assume that with a cost modifier of 25% and 
then one of 75%, the job cost would be zero. That is incorrect simply because the 
modifiers are cumulative, each one acts on the previous value, not the original job cost. 
 
 
Validated Values Overview 
Print Audit supports a feature called Validated Values. This feature is similar to the 
Clients feature provided in Print Audit Enterprise. The main difference is that you can 
now name this validated value whatever makes the most sense for your business. You 
may choose to name it, “Client”, “Project”, or “Account”, for example. 
If you turn on the Use Validation option on the Popup Window Settings tab, the user 
must enter a correct value on the Print Audit Client Popup to validate a print job. Print 
Audit checks the value they enter on the popup against the list of values you enter into 
the database. If there is a match, the user can continue. If no match is found, the user is 
not allowed to continue printing. 
You enter values the user can be validated against, either in the Print Audit Wizard, or on 
the Validated Values tab in the Administration tool. You can enter as many values as you 
like, the only restriction is that the code field for each value be unique within the 
database. 
You can also specify a cost modifier for a validated value, which Print Audit then uses in 
calculating the cost of printing a job. For more information on costs, see Printing Costs. 
To name the validated field something that makes sense for your business, use the Popup 
Window Settings tab in the Administration tool, or the Validated Values section of the 
Print Audit Wizard.  
 
User Security Overview 
Print Audit supports user validation of jobs. This allows you to define users in the Print 
Audit database and assign them PIN codes.  If you are not concerned about securing 
printing on a user-by-user basis, you do not need to use user validation. 
If you turn on the Require user to enter a PIN code option, the user must enter a valid 
PIN code on the Print Audit Client. Print Audit checks to ensure the PIN code is correct, 
and stores the user who printed the job in the database. If the user does not have a valid 
PIN code, their only option is to cancel the print job.  
You can enter users in the Print Audit Wizard or on the Users and Security Tab of the 
Print Audit Administration tool. You can add as many users as you want, the only 
restriction is that PIN codes must be unique across users. 
This functionality is ideal in situations where you have a shared workstation and 
windows login for printing, but still want to track which users are printing what. 

Technical support can be obtained via the following: 
• Our web site http://www.printaudit.com or E-mail: support@printaudit.com 
• Telephone toll free in North America 877 41 AUDIT (28348) or outside of North America 403 685-4932 (Canada) 

Page 26 



 

Educational institutions and real-estate offices are just two examples of environments in 
which this functionality would be useful. 
 
Application Security Overview 
Print Audit implements two types of security: Application level security and Print Job 
level security. Print job security is implemented through user validation. Click here for 
more information on user validation. 
Application security requires the user to enter a valid PIN code before they can use the 
Administration or Viewer tools. You can enter users in the Print Audit Wizard or on the 
Users and Security Tab of the Print Audit Administration tool. You can add as many 
users as you want, the only restriction is that PIN codes must be unique across users. 
To turn on security for the Administration tool, check the Administration requires PIN 
code option on the Users and Security tab of the Administration tool. Once checked, the 
next time someone goes to use the Administration tool they must supply a PIN code. The 
user for that PIN code must have Administrator rights. 
To turn on security for the Viewer tool, check the Viewer requires PIN code option on 
the Users and Security tab of the Administration tool. Once checked, the next time 
someone uses the Viewer tool they must supply a PIN code. A user can have three 
different levels of viewer access: None, Own Data or All Data. If None, they cannot enter 
the viewer. If Own Data they can enter the viewer tool, but they can only see their own 
print jobs. If All Data, then they can view all users print jobs. 
 
 
Quotas Overview 
Print Audit allows you to specify a dollar value that acts as a quota for a user. Every time 
a user prints a job, Print Audit subtracts the cost from their quota. Once the quota reaches 
zero, that user can no longer print. To use quotas, you must turn on the Require user to 
enter a PIN code option on the Popup Window Settings tab of the Administration tool. 
You can then add users on the Users and Security Tab, turn on the quotas and enter quota 
amounts for the users. 
 
 
Application Tracking Overview 
Print Audit allows you to specify different tracking options for different applications. To 
add/edit applications and set their tracking options, use the Applications tab.  
You can also use this to resolve some "double-pop" issues. For example, some 
specialized printer drivers add post-processing procedures, like watermarking, to print 
jobs. In these cases, Print Audit correctly determines that two print jobs have been done, 
one from the application you are printing from, and one from the driver. You can add the 
driver executable name to the list, and have Print Audit ignore any jobs coming from the 
driver. 
 To add and edit applications, use the Applications Tab and the Application Edit 
Window. 
Some examples of how you can use this functionality are listed below. 
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Example One 
For example if you want to track printing from Outlook but you do not want the Print 
Audit Popup to appear every time someone prints their email, you could add 
OUTLOOK.EXE to the application list and set its tracking option to Track with no 
popup. 
 
Example Two 
If you want to have the popup come up when your users are printing from Microsoft 
Word, but you do not care about printing from any other apps, you would check the 
Track only these applications box on the Applications Tab and add the process 
WINWORD.EXE to the list with the Track with Popup option set. 
 
NOTE: Any tracking options you set for applications override the printer configuration 
tracking options. (For more information Table of Contents: Print Audit 4 Administration 
Overview: Tracking Options Overview.) 
. 
 
Printer Configurations Overview 
Print Audit allows you to create and store printer configurations. These configurations 
allow you to assign different tracking and pricing options to different printers within your 
organization. This allows you complete control over the structuring and tracking of your 
organizations’ printing needs from one central point. 
For example, you may want to define a printing configuration for simple desktop printing 
to a standard laser printer and define another for printing to a high-speed color laser 
printer/copier. You can assign different costs and tracking options for each of these to 
reflect the importance of the different types of printing. 
Once you define the printer configuration, you can setup a Print Audit Printer. Print Audit 
Printers take care of matching a printer configuration to your physical printer. Generally, 
Print Audit uses the network port to which your printer is connected to do the matching. 
For example, you could create a Print Audit Printer and name it, “5th Floor Laser Printer” 
and then set the Port field of the Print Audit Printer to the physical network port of the 
printer, which may be something like “\\MYSERVER\LASER”. Then whenever Print 
Audit detects any printing from a desktop to that port, it uses the configuration you have 
assigned to the Print Audit Printer. For more information, see the Printers Tab and the 
Printer Edit Window. To successfully match printers when tracking plotting from some 
CAD programs, you can also enter other values in the Port field. (For more information, 
see Table of Contents: Print Audit 4 Administration Overview: CAD Plot Tracking 
Overview.) 
Print Audit also supports a “default configuration”. You set up this configuration with 
your default costs and tracking options, and set it as the default configuration on the 
Printers Tab. Then any printer which does not specifically have a printer configuration 
assigned to it uses the defaults. 
For example you may have over a hundred printers in your organization that you simply 
want to charge .25 cents per page for, and one high-end color laser printer/copier for 
which you want to charge 1.00 per page. To set up all of these printers all you need to do 
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is create one configuration for your everyday printing and set it as the default 
configuration. Then create a configuration containing your costs for the high-end color 
laser printer, and add a printer to Print Audit that uses that configuration and matches to 
the network port of the printer. 
 
To add and edit printer configurations – use the Printer Configurations Tab and the 
Printer Configuration Edit Window. 
To assign configurations to printers – use the Printers Tab and the Printer Edit 
Window. 
 
 
Tracking Options Overview 
Print Audit tracking options allow you to fully customize Print Audit – it will track jobs 
within your organization the way you want it to. You can assign these options to Printer 
Configurations and Applications.  
Tracking options assigned to applications override options assigned to Printer 
Configurations. For example, if you set up Print Audit to Track with no Popup for a 
printer called Laser Printer, but set up Print Audit to Track with Popup for all printing 
from Microsoft Word, when the user prints to Laser Printer from Microsoft Word, the 
popup will appear. 
The Track with no popup option can cause some confusion when viewing the data in 
the Viewer. You will notice that several fields have "Unknown" as their value. That is 
because Print Audit gets those values from the Print Audit Client Popup window. So even 
if you turn on the Require user to enter a PIN code option on the Popup Window 
Settings tab, the user will read "Unknown" if the job was tracked with no popup. 
 
Print Audit supports three different tracking options: 
Track with popup – When printing, the Popup window will appear. 
Track with no popup – Print Audit tracks the job, but no popup window appears. 
Do not track job – Print Audit allows the job to go through with no tracking taking 
place. 
 
 
Purging Print Jobs 
Print Audit allows you to delete print jobs from the database. You should do this 
periodically when you no longer need old data. This is especially critical because having 
a large number of jobs in the database can decrease the overall performance of Print 
Audit. Once you delete these jobs, they are gone for good, so we recommend that you 
make absolutely sure that you no longer need the data. 
We also recommend that after you purge a large number of print jobs from an Access 
database that you use the Print Audit Compact Database utility. 
 
To purge print jobs: 
1 Click the Options->Purge Job Records menu item. The Purge Jobs window appears. 
2 Select the From Date using the drop down calendar.  
3 Select the To Date using the drop down calendar. 
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4 Click the Purge button. A message box appears asking you to confirm that you want to 
delete the jobs. 
5 Click the Yes button on the message box. The message box closes and Print Audit 
deletes all print jobs printed between the From Date and the To Date. After Print Audit 
finishes deleting the jobs, a message box appears telling you the operation is complete. 
6 Click the OK button on the message box. 
This box contains the error message that Print Audit displays to the user when they 
exceed the maximum number of pages. If you leave this box blank, Print Audit displays a 
default message. The message is limited to 255 characters. To put in a carriage return, 
hold down CTRL and hit ENTER. 
 
Compacting the Database 
Print Audit uses a Microsoft Access 2000 database to store data.  Due to the nature of 
Microsoft Access 2000, you should compact this database periodically. This reduces 
overall database size and prevents problems from occurring in the future. We recommend 
compacting the database at least once a month. 
 
To compact the database normally: 
1 Ensure that no one is running the Print Audit Administration or Viewer programs; these 
“lock” the database. If it is locked you cannot compact. The Print Audit Client only locks 
the database if writing a print job, so you should not need to shutdown every client. 
2 Click Start->Programs->Print Audit 4->Compact Database from the Windows Start 
Menu. The Compact Database window appears. Please note that Print Audit installs this 
component only if you installed the Print Audit Administration component. 
3 Click the Open Database button to open a dialog that allows you to select the Print 
Audit database you want to compact. The Compact Database program defaults to the 
current database setup on the computer. Only select a different one if you need to. 
4 Click the Compact button. The compact utility compacts your database. A message 
box appears letting you know when Print Audit finishes compacting the database. 
5 Click Close to close the compact database program. 
 
To compact the database from the command line: 
1 Ensure that no one is running the Print Audit Administration or Viewer programs; these 
“lock” the database. If it is locked you cannot compact. The Print Audit Client only locks 
the database if writing a print job, so you should not need to shutdown every client. 
2 Start an MS-DOS session. 
3 Type the full path to the compact utility, followed by a space, -c, another space and the 
full path to the database you want to compact. If you do not include the path to the 
database then Print Audit compacts the currently setup database. 
4 Press the Enter key. Print Audit compacts the database. 
 
 
For example, if you could type the following (X corresponds to the drive where you 
placed the database): 
c:\program files\print audit 4\admin\pacompact.exe –c X:\printaudit.mdb 
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You can use this method of compacting within a batch file, which you can schedule to 
run periodically. 
 
 
Silent Installation 
 
Print Audit allows you to set up the installation for a silent install. This allows you to run 
the install in a login script or through some other automated means with no user-
interaction necessary. 
 
To silently install Print Audit: 
 
1 Set up your Print Audit silent installation configuration file and store it in a 
directory accessible to the installation program. For more information on the 
configuration file, see below. The Print Audit installation program has an option to create 
the file for you. We highly recommend you use it. 
 
2 Either on the command-line or in a batch file execute the installation program 
followed by "/s" followed by the full path to the configuration file. If the silent 
configuration file is in the same directory as the installation program you do not need to 
enter the full path. 
 
3 Hit the Enter key or run the batch file. Print Audit silently installs the program. 
 
Silent Install Configuration File Format 
 
The silent install configuration file follows the same format as a standard Windows .ini 
file. A list of all elements of the file follows: 
[INSTALL] – This is the main section for the file. Most keys are underneath this section. 
It must be present. 
MainDir – This sets the root install directory for the software. If this key is not present, 
the install assumes a value of X:\Program Files\Print Audit 4 where X is equal to your 
main system drive. 
 
Group – This sets the program group name where you want the Print Audit shortcuts to 
be setup. 
Client – You can set this key to either 0 or 1. A value of 1 means to install the 
component. If this key is not present the install assumes a value of 0. 
Administrator- You can set this key to either 0 or 1. A value of 1 means to install the 
component. If this key is not present the install assumes a value of 0. 
Viewer – You can set this key to either 0 or 1. A value of 1 means to install the 
component. If this key is not present the install assumes a value of 0. 
 
Reporter – You can set this key to either 0 or 1. A value of 1 means to install the 
component. If this key is not present he install assumes a value of 0. 
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AutoRun – You can set this key to either 0 or 1. A value of 1 means to run the Print Audit 
Client when Windows starts. Please note that the client component must be installed for 
this to work. If this key is not present the install assumes a value of 0. 
Uninstall – You can set this key to either 0 or 1. A value of 1 means that the installer 
includes uninstall information on the system when installing. A value of 0 means that no 
uninstall information is put on the computer. If there is no un-install information, there is 
no clean way to remove Print Audit from the system. If this key is not present the install 
assumes a value of 1. 
 
Micropath – You can set this key to the path to your Microstation/J executable. This 
forces the installation program to install and configure the Microstation plug-in. Only use 
this key if Print Audit has problems installing the Microstation plug-in automatically. For 
example the default path to the Microstation executable (ustation.exe) is: 
X:\Bentley\Program\Microstation 
where X is the drive where you installed Microstation/J. 
 
[DATABASE] – This section contains all database configuration information. 
 
DBPath – This key contains the path to the database. If not present the install assumes a 
path equal to the root of the main installation directory. If you specified the Database key 
in the [INSTALL] section then the install installs the database to this path and file name. 
If you did not specify the Database key, then the install only saves this record in the 
registry as the default path to the Print Audit database. 
 
Configuration File Example 
 
REM Installs all files. Assumes ADO is proper version and a Print Audit database 
already exists and we do not want to REM force install the Microstation plug-in. 
 [INSTALL] 
MainDir=C:\Program Files\Print Audit 4 
Client=1 
Administrator=1 
Viewer=1 
Reporter=1 
AutoRun=1 
 
[DATABASE] 
DBPath=c:\temp\printaudit.mdb 
 
CAD Plot Tracking Overview 
Print Audit 4 includes new features that enhance the capture of plotting information from 
the most popular CAD programs. Generally the new features are in the form of plug-ins 
written specifically for a CAD program to interface with Print Audit, and are installed 
automatically if the Print Audit installation program detects the programs on the system. 
By default, Print Audit tracks plotting from any CAD program which uses Windows 
printer drivers for the printing. However, some programs such as AutoCAD support 
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plotting to their own proprietary plotting drivers such as ADI and HDI that Print Audit 
would not normally capture. Below is a list of the CAD programs for which Print Audit 
has added extended support. 
• AutoCAD R14  
• AutoCAD 2000 and Later  
• AutoCAD LT Products  
• Microstation/J  
 
 
AutoCAD R14 Plotting Overview 
Print Audit fully supports the capture of plot information from AutoCAD R14. We track 
plotting to the Windows system printers as well as AutoCAD custom ADI drivers. 
No additional plug-in is installed for AutoCAD R14. Print Audit does not re-define the 
AutoCAD PLOT command, so any custom PLOT commands you might define remain 
unaffected. The plug-in works with the AutoCAD Batch Plot Utility, as well as any 
custom COM applications you may have written which plot through AutoCAD. 
 

Plotter Matching When Using ADI 
Print Audit has additional support for printer matching when using CAD programs. If you 
are not sure how Print Audit uses printers and configurations to help you manage your 
printing, see Table of Contents: Print Audit 4 Administration Overview: Printer 
management Overview). 
Printer Management. Below are some scenarios that affect how Print Audit matches its 
own Printers with your physical plotters. 
 
ADI Driver Bound to a Network Port 
If you set up your ADI driver to bind to a network printer for its port, the printer 
matching in Print Audit works the same as it does if you are using a Windows printer. 
This is the normal way to set-up ADI drivers, as it allows you to have the output from the 
ADI driver go directly to the plotter. 
 
ADI Driver Bound to a Local Port 
You can also set-up your ADI driver to bind to a local port, like LPT1 or COM1. 
Generally, you would only do this if you only plotted to file with your ADI driver, and 
then had some other process that took the raw file and dumped it to the plotter. There are 
two different ways you can use printer matching in this scenario. 
1 You can enter the name of the local port in the Port field for the printer on the Printer 
Edit Window. For example, you would enter COM1 as the Port value on the edit 
window. Print Audit would then search for that port in your Print Audit Printers list, and 
match successfully. If you have several different ADI plotters which you have bound to 
the same local port and you want to have different pricing configurations for that plotter 
this method may not be effective. 
2 You can enter the plotter model name in the Port field for the printer on the Printer 
Edit Window. This allows you to setup different pricing/plotting configurations for your 
plotters based on the model of the plotter. Print Audit would then search for that model 
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name in your Print Audit Printers list and match successfully. To find the model name for 
any plotter you set up in AutoCAD R14, go to the File->Printer Setup menu item in 
AutoCAD R14. If you click on the name of the printer for which you want to see the 
model name, it displays in the gray box at the bottom of the window. 
 
 
AutoCAD 2000 and Later Plotting Overview 
Print Audit fully supports the capture of plot information from AutoCAD 2000 and later. 
So far, this includes the 2000, 2000i, and 2002 family of products. We track plotting to 
any Windows system printers as well as pure HDI printer drivers. 
Print Audit supports HDI plot tracking through the use of AutoCAD ObjectARX plug-
ins. Print Audit automatically installs these, along with the Print Audit Client if it detects 
compatible products on your machine. These plug-ins do not re-define the PLOT 
command in any way, so any custom work you have done with the PLOT command are 
not affected. These plug-ins work with the AutoCAD Batch Plot Utility as well as any 
custom COM programs you may have written which plot through AutoCAD. 
 

Plotter Matching When Using HDI 
Print Audit has additional support for printer matching when using CAD programs. If you 
are not sure how Print Audit uses printers and configurations to help you manage your 
printing, see Table of Contents: Print Audit 4 Administration Overview: Printer 
Management Overview. 
Below are some scenarios that can affect how Print Audit matches its own Printers with 
your physical printers. 
 
HDI Driver Bound to a Network Port 
If you set up your HDI driver to bind to a network printer for its port, the printer 
matching in Print Audit works the same as it does if you are using a Windows printer. 
This is the normal way to set-up HDI drivers as it allows you to have the output from the 
HDI driver go directly to the plotter.  
 
HDI Driver Bound to a Local Port 
You can also set-up your HDI driver to bind to a local port like LPT1 or COM1. 
Generally, you would only do this if you only plotted to file with your HDI driver and 
then had some other process that took the raw file and dumped it to the plotter. There are 
two different ways you can use printer matching in this scenario. 
 
 
 
1 You can enter the name of the local port in the Port field for the printer on the Printer 
Edit Window. For example you would enter COM1 as the Port value on the edit window. 
Print Audit would then search for that port in your Print Audit Printers list, and match 
successfully. If you have several different HDI plotters that you have bound to the same 
local port and you want to have different pricing configurations for that plotter, this 
method may not be effective. 
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2 You can enter the plotter model name in the Port field for the printer on the Printer 
Edit Window. This allows you to setup different pricing/plotting configurations for your 
plotters based on the model of the plotter. Print Audit would then search for that model 
name in your Print Audit Printers list and match successfully.  
 

HDI Port Settings 
The AutoCAD 2000 family of products allows you three different options when setting 
how an HDI driver will plot. You can choose from Plot to the following port, Plot to 
File and Autospool. While these settings affect what AutoCAD does with the output 
from the driver, it has no affect on how Print Audit tracks the plot. To successfully 
employ printer matching, we recommend you first select the Plot to the following port 
option and choose the port you need to successfully match with Print Audit. Then select 
one of the other plot output options if you need to. This way Print Audit will match 
properly no matter how you direct the output. 
 
AutoCAD LT Plotting Overview 
Print Audit supports plot tracking from the AutoCAD LT family of products only when 
printing to Windows system printers. The AutoCAD LT family of products do not 
support plug-ins, so at this time we cannot get ADI or HDI printing. 
 
Microstation/J Plotting 
Print Audit fully supports the capture of plot information from Microstation/J. We track 
plotting to the standard PRINTER.PLT Microstation plotter which uses the current 
Windows system printer as well as plotting using any of the other Microstation custom 
plotter drivers. 
Print Audit supports plot tracking from Microstation plotter drivers through the use of a 
Microstation MDL plug-in that interfaces with our standard library of Print Audit 
functions. Print Audit automatically detects if you have Microstation/J installed and 
installs the plug-in files and configures Microstation to automatically load the plug-in for 
you. Please note that you cannot plot using Microstation if the plug-in is installed and the 
Print Audit client is not running. 
 
Plotter Matching When Using Microstation Plot Drivers 
Print Audit has additional support for printer matching when using CAD programs. If you 
are not sure how Print Audit uses printers and configurations to help you manage your 
printing, see Table Of Contents: Print Audit 4 Administration Overview: Printer 
Management. Below are some scenarios that can affect how Print Audit matches its own 
Printers with your physical printers. 
PRINTER.PLT 
If you use the Microstation PRINTER.PLT plotter driver, Print Audit matches to the 
Windows system printer name. 
 
Microstation .PLT Driver Set to a Network Port 
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printer. You can just enter this port in the Port field of the Printer Edit Window and Print 
Audit will successfully match.  
 
Microstation .PLT Driver Set to Print to File 
By default Microstation plotter drivers dump their output to a file. To successfully match 
Print Audit Printers to your physical plotter you can enter the name of the Microstation 
Plotter driver in the Port field of the Printer Edit Window. For example you could enter 
CAL960.PLT in the Port field of a Print Audit printer. Then whenever you use 
Microstation and plot using that driver Print Audit searches through its list of printers and 
finds the correct plotter to match. 
 
MICROSOFT ACCESS READ-ONLY ACCOUNT 
For your convenience we added a read-only account to our MS Access database security 
file. This allows you to open the database using MS Access 2000 and above and read 
some of the tables directly. The account name is PAReadOnly. The default password for 
this account is "password". We highly recommend that you change this password as soon 
as possible as users can use it to bypass some of the security measures in Print Audit. 
You can change the password using Microsoft Access or using the Administration tool. 
 
To change the read-only account password in the Administrator: 
1 Click the Options->Set Read-only DB Password menu option. The Change 
Password dialog box appears. 
2 Enter the current password of the read-only account. 
3 Enter the new password in the New box. 
4 Re-enter the same password in the Confirm box. 
5 Click the OK button. The Change Password dialog closes and a confirmation message 
displays. 
 
The read-only account provides read access to the following tables: 
• tblApplications – Contains the list of applications as defined on the . 
• tblPrintJobs – Contains all of the print job data. 
• tblUsers – Contains a list of the users as defined on the Users tab. Please note  
 that the PIN code is encrypted for extra security. 
• tblValidatedValues – Contains a list of the values in your validated field. 
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PRINT AUDIT 4 VIEWER OVERVIEW 
 

 
Print Audit 4 Viewer gives you access to your printing data. You can use it to view the 
information, export the information in virtually any type of flat file format, as well as to 
do a quick print of the data in tabular format. 
The Viewer also allows you to export the information for accounting purposes. Print 
Audit keeps track of the jobs that have previously been exported for accounting so you 
can be sure that all data is captured once and once only. 
Below is a list of all the main functions supported in the Viewer. 
• Searching for Print Jobs  
• Customizing Your View  
• Exporting the Print Jobs  
• Using Print Audit for Accounting  
• Printing Print Jobs  
 
 
Searching for Print Jobs 
The first step when using the Print Audit Viewer is to search for the jobs you want. You 
can search in several different fields, as outlined below. You can use any combination of 
the fields, or use none. Please note that the larger the number of jobs, the slower any 
operation is on the data, so make sure that you are only getting the data you need. 
Please note that any search criteria in the window, such as date, user, etc. are taken into 
consideration for the search. 
Click here for information on the columns Print Audit returns. 
 
To search for jobs for a specific Print Audit user: 
1 Type the full or partial user name in the User field. Depending on your security, this 
field might be read-only with your name already in it. In this case, you can only view 
your own jobs. 
2 Click the Results button to display any print jobs matching the user. 
 
To search on the validated field: 
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2 Click the Search button to the right of the box to validate the information. If the text 
turns black, you have selected the value, so proceed to step 5. 
3 On the Search window, click on the grid row containing the value you want. If no rows 
appear on the window then no matches were found. Use the search window to find the 
value you want. 
4 Click the Select button to select the value and close the window. 
OR 
4 Click the Cancel button to return to the main Viewer window. 
5 Click the Results button to display any print jobs matching the value. 
 
To search on a specific printer or port: 
1 Type the full or partial name of the printer for which you want to find jobs in the 
Printer box. 
OR 
1 Type the full or partial port of the printer for which you want to find jobs in the Printer 
box. 
2 Click the Results button to display print jobs matching the printer. 
 
To search for a value in a user-defined field: 
1 Type the full or partial value you want to search for in one of the user defined field 
boxes. These fields are named differently depending on your administration settings. 
2 Click the Results button to display print jobs containing the user-defined value. 
 
To search on a specific network user: 
1 Type the full or partial name of the network user for which you want to find jobs in the 
Network User box. 
2 Click the Results button to display print jobs matching the selected network user. 
 
To search for a specific date: 
1 Click on the From Date drop down box. A miniature calendar appears below the box. 
2 Use the calendar to choose the starting date for which you want to search. 
3 Click on the To Date drop down box. A miniature calendar appears below the box. 
4 Use the calendar to choose the ending date for which you want to search. 
5 Click the Results button to display print jobs matching the selected date range. 
 
 
Printing Print Jobs 
Once you search for print jobs, you can print the results to any printer. The information 
you print appears exactly as it does in the results grid. For example, if you expand all of 
the details out when you print all of the details are expanded. 
 
To print job information: 
1 Follow the instructions in Searching for Print Jobs to get the search criteria you want. 
2 If you have not already, click the Results button. The results of your search appear in 
the grid on the window. 
3 Click File->Print Results. The Select Columns window appears. 
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4 Click to the left of the column names to select/deselect the columns you want to print. 
If checked, the column is printed. 
5 Enter any header you want to appear on the report in the Header box. Print Audit 
places this text at the top of every page in the report. 
6 Click the Print button or the Preview button to print or print preview the information. 
The printer dialog window appears. 
7 Use this dialog to select the printer and any page size you want to use. 
8 Click the OK button to print the information. 
 
If the columns are too wide to fit on the page selected, Print Audit asks you if you want to 
resize the columns to fit. If you choose Yes, Print Audit resizes the columns to fit on one 
page width. This can cause distortion in the printing information. You may have to allow 
the columns to span pages, or choose not to print some of the columns. 
 
Exporting Print Jobs 
Print Audit allows you to export your print job information in virtually any format you 
need. You can set-up these custom exports and save them. Once they are created you can 
use them to export the data at any time. The data can then be imported into any program 
to further massage the data, for accounting purposes or whatever. 
 
Customizing Your View 
Once you search for print jobs, you can view the information and sort/sub-total on several 
different fields. You can hide columns, change the order of the columns as well as change 
the size of the columns. Once you have the data in the configuration you want, you can 
save that view to use any time you want. You can save as many views as you want. 
 
Setting Up the View 
Below are instructions for configuring your view of the data. For general information on 
views see Customizing Your View  (above). 
 
To total the information on a specific column: 
1 Follow the instructions in Searching for Print Jobs to get the jobs you want. 
2 Ensure that you check the Calculate totals checkbox. 
3 Right-click on the column header for the column you want to total on. A popup menu 
appears. 
4 Click on the Total on Column menu. The column moves to the left and the data sorts 
and totals on that column. 
5 You can use the Expand, Collapse buttons and the plus/minus signs at the left of the 
columns to view or hide the detail rows for the totals. 
NOTE: You can only total on the columns with highlighted headers. 
 
To change the position of a column: 
1 Click and hold the left mouse button on the header of the column you want to move. 
The header changes to look "pressed". 
2 Move the mouse in the direction you want to move the column. An outline appears in 
the new column position. 
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3 Release the mouse button once it is in the position you want. The column moves to the 
new position. 
 
To hide a column: 
1 Right-click on the column header for the column you want to hide. A popup menu 
appears. 
2 Click on the Hide Column menu. The column disappears. 
 
 
To show hidden columns: 
1 Click the View->Reset View menu item. The view resets to the default view. 
OR 
1 Reselect the view, if any, that you are currently in. If you have not saved the view since 
you hid the columns you will revert to the old view. 
 
To change the width of a column: 
1 Move the mouse to the right edge of the header for the column you want to resize. The 
cursor will change to a re-size cursor when you are in the right spot. 
2 Hold down the left mouse button and move the mouse right to make the column larger, 
left to make it smaller. An outline draws to show you the new column size. 
3 Release the mouse button when the column is the size you want. The column resizes. 
 
 
Saving Changing and Deleting Views 
Below are instructions for managing your views. (For general information on views, see 
Table of Contents: Print Audit 4 Viewer Overview: Customizing Your View.) 
 
To save the current view: 
1 Click the Save View button. If it is a new view, a message box appears asking you for 
the name of the view. Otherwise you are done. 
 
To select a view: 
1 Click the View dropdown combo box. A list of all of your saved views appears. 
2 Click the view you want to switch to. The columns reset to that view. 
 
To copy a view: 
1 Select the view you want to copy using the View dropdown box. 
2 Click the Save View As button. A message box appears asking for the name of the new 
view. 
3 Enter the name of the new view. 
4 Click the OK button. The window closes and your new view displays. 
 
To delete a view: 
1 Select the view you want to delete using the View dropdown box. 
2 Click the Delete View button. A message box appears to confirm that you want to 
delete the view. 
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3 Click the Yes button on the message box. The message box closes and the view deletes 
from the list. 
 
Custom Exports Overview 
Print Audit allows you to create as many custom export configurations as you want. Once 
you create these configurations you can use them to put Print Audit’s data into a format 
compatible with almost any program. 
 
To create an export configuration: 
1 Click the Tools->Export->Configurations menu item. The Export Configurations 
Window appears. 
2 Make the changes you want to the export configuration. For more information on the 
export configuration fields and what they do, see the Export Configurations Window 
(below). 
3 Click the Save As button. A message box appears asking you for the name for the new 
configuration. 
4 Enter the name of the new configuration. 
5 Click the OK button. The message box closes and you are done. 
 
To edit an export configuration: 
1 Click the Tools->Export->Configurations menu item. The Export Configurations 
Window appears. 
2 Use the Configurations dropdown box to select the configuration you want to change. 
3 Make the changes you want to the configuration. For more information on the export 
configuration fields and what they do, see the Export Configurations Window. 
4 Click the Apply button. The changes save and you are done. 
 
To delete an export configuration: 
1 Click the Tools->Export->Configurations menu item. The Export Configurations 
Window appears. 
2 Use the Configurations dropdown box to select the configuration you want to delete. 
3 Click the Delete button. A message box appears asking you to confirm you want to 
delete the configuration. 
4 Click the Yes button on the message box. The configuration deletes and you are done. 
 
 
 
Export Configurations Window 
This window allows you to create, modify and delete export configurations. These 
configurations are then used to format data for exporting. (For more information on 
exporting, see Table of Contents: Print Audit 4 Viewer Overview: Exporting Print Jobs.) 
 
Configuration – Use this drop down box to select the configuration you want to edit. 
The list is the list of all configurations you have previously created. 
Save As Button – Use this button to create a copy of the currently selected configuration. 
Delete Button – Use this button to delete the currently selected configuration. 
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Output File – This field contains the path and name of the file you want the export to go 
to. 
File Browse Button – Click this button to open a standard Windows save dialog box. 
Use this box to choose the path and enter the name of the output file. 
Save Button – Click this button to save the changes to the current configuration. 
Close Button- Close the Export Configurations window. 
 
Options Tab 

 
Delimited Option – Click this option to have the export use a delimiter that you define to 
separate fields in a row of output. The most common type of delimiter is a comma. Most 
programs can import comma-delimited files. 
Fixed Width Option – Click this option to have the export use a fixed width for each 
column to separate the fields in a row of output. For example, for a fixed width export 
you can set a column to be 10 characters. Even if there are only 5 characters in the data, 
the field will be padded out to 10 characters. 
Field Delimiter (Delimited Only) – This field contains the character you want to use to 
delimit the fields. Some common values are commas, pipe characters and tab character. 
To use the tab character you must enter the text "<TAB>" (without the quotation marks). 
This is the only special value, Print Audit interprets every other value exactly. 
Add on Row Start (Delimited Only) – If checked, this tells Print Audit to add a field 
delimiter at the start of a row. For example if you use a comma as a delimiter, a row 
containing two values would look like this ",1,2". 
Add on Row End (Delimited Only) – If checked, this tells Print Audit to add a field 
delimiter at the end of a row. For example if you use a comma as a delimiter, a row 
containing two values could look like this "1,2,". 
Enclose Strings in Quotes (Delimited Only) – If checked, this tells Print Audit to put all 
strings in quotation marks. This is particularly important if you are using a comma as a 
delimiter, but some of the text fields have commas as well. That would cause the program 
you are using to import to behave incorrectly. 
Output Column Name Row (Delimited Only) – If checked, the first row that Print 
Audit exports is a row of names for all of the columns you are exporting. 
Row Delimiter Type – Use this dropdown box to select the end of row delimiter. The 
most common type of row delimiter is a combination of a Carriage Return character and 
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a Linefeed Character. If you choose Custom, then you can delimit the row with any type 
of character. 
Append to Existing File – If checked and the named output file exists, this tells Print 
Audit to append the data to the end of the file. If cleared, Print Audit overwrites any 
existing data in the file. 
Date Format – This field allows you to define a custom date format for any dates in the 
export. The date format follows the VBA date formatting characters. In general, m – 
month, d – day, y – year. (For more information on date formats, see Table of Contents: 
Print Audit Viewer Overview: Date Formats.) 
Date Format Preview Button- Click this button to preview how your entered date 
format will affect the date. 
 
Columns Tab 

 
Totals Only – If checked, this tells Print Audit to run totals based on the column selected 
to the right. This creates a file containing only the total for each job. If it is clear, no totals 
are calculated, and all the detail rows are exported. 
Totals Field – Use this dropdown to select the field you want to total on. Only valid if 
Totals Only is checked. 
Name Column – This contains the name of the data column to export in this position. 
Click on the cell to enable a dropdown combo that you can use to select a different data 
column. You can also type free form text into this cell. If you do, that text appears in 
every row in the export. 
Width Column (Fixed Width Only) – In a fixed width export, this cell contains the 
number of characters for this data column. 
Right Justify Column (Fixed Width Only) – If checked, pads the data column on the 
left, otherwise it pads on the right. 
Pad Char Column (Fixed Width Only) – In this column you can specify the pad 
character to use when padding the fixed width column. Generally this is a space 
character. 
Add Column Button – Click this button to add a blank row to the export columns grid. 
You can then click in this row to select a data column and enter the other pertinent 
information. 
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Remove Column Button – Click this button to remove the currently selected row from 
the export columns grid. 
Move Up Button – Click this button to move the selected row up in the list. The orders 
of the rows indicate the left-right order of the data columns in the export. 
Move Down Button – Click this button to move the selected row down in the list. The 
order of the rows indicates the left-right order of the data columns in the export. 
 
 
Exporting Search Results 
Print Audit allows you to use custom export configurations to format data from the Print 
Audit database to a flat file. One way to export is to export the current search results in 
the grid. Please note that Print Audit ignores the any view configuration you have set, 
instead it uses only the export configuration. (For more information on exporting, see 
Table of Contents: Print Audit Viewer Overview: Exporting Print Jobs.) 
 
To export search results: 
1 Follow the instructions in Searching for Print Jobs to get the jobs you want to export. 
2 Click the Tools->Export->Current Results menu. The Choose Export Configuration 
window appears. 
3 Use the Configuration drop down box to choose the configuration you want to use for 
the export. 
4 Click the Export button to have Print Audit start exporting the data. 
 
 
Exporting for Accounting 
Print Audit allows you to use custom export configurations to format data from the Print 
Audit database to a flat file. One type of export is an accounting export. This type of 
export is identical to a regular export except that Print Audit keeps track of which rows 
have previously been exported. You can also run this type of export from a command 
prompt or a batch file. For example, this allows you to run a process every 24 hours that 
takes the most recent data and dumps it already formatted to some flat file from which 
your accounting program can import it automatically. 
For more information on exporting, see Exporting Print Jobs. 
 
To export for accounting in the Viewer: 
1 Click the Tools->Export->Run Accounting menu. The Choose Export Configuration 
window appears. 
2 Use the Configuration dropdown box to choose the configuration you want to use for 
the export. 
3 Click the Export button. All non-accounted rows are exported to the file specified in 
the export configuration. 
 
To export for accounting from the command line: 
1 Type the following into a command-prompt (separate each parameter with a space): 
X:\PATH\paviewer.exe –a <config name> <pin code> 
Where X:\PATH corresponds to the installed directory of the viewer executable. 
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<config name> – Corresponds to the configuration name to use for the accounting run. 
Must be entered. 
<pincode> – Corresponds to a PIN code for someone who has all data access to the 
viewer. Not needed if the viewer is not secured. 
 
NOTE: if there are spaces in the path, pin code or configuration name you must enclose 
them in quotes. 
For example: the following line runs the viewer in accounting mode, using a PIN code 
“mypincode” and uses the export configuration “Excel Format” to format the print jobs: 
“C:\Program Files\Print Audit 4\viewer\paviewer.exe” –a “Excel Format” mypincode 
 
To clear an accounting run: 
1 Click the Tools->Export->Clear Last Accounting Run menu. A message box appears 
to confirm that you want to clear the last run. 
2 Click the Yes button on the message box to start clearing the run. A message box 
appears to tell you when you are done clearing the run. 
 
 
Validated Field Value Search Window 
This window allows you to search for values for the validated field. Once you find the 
value you want, you can select it so Print Audit can use it in the print job search. The 
name of the validated field depends on settings in the Administration program. 
 
Search – Type the code or description of the value you want to find here. The results in 
the grid narrow according to what you type. 
Code – Click this option for the search to be by the code of the value. 
Description – Click this option for the search to be by the description of the value. 
Results Grid – This table displays the results of the search. Click on the row in the grid 
that you want to select. 
Select Button – Click this button to select the highlighted row and return to the main 
window. 
Cancel Button – Click this button to cancel the search and return to the main window. 
 
 
Print Job Columns 
Below is a list of all the columns Print Audit returns when searching for print jobs. All of 
these columns are available for both printing and exporting. The columns are listed in 
their default left to right order. 
 
Value Code – This column contains the code of the validated field value. The full name 
of this column depends on what you named the validated field. This column contains 
“unknown” if the job was tracked without a popup or if you chose not to use the validated 
field. 
 
Value Description – This column contains the description of the validated field value. 
The full name of this column depends on what you named the validated field. This 
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column contains "unknown" if the job was tracked without a popup or if you chose not to 
use the validated field. 
 
User – This column contains the name of the Print Audit user who printed the job. This 
column contains “unknown” if the job was tracked without a popup or if you chose not to 
use the validated field. 
 
Network User – This column contains the windows network login name of the user who 
printed the job. This column contains "unknown" if there was no network present. 
 
Computer – This column contains the windows network computer name of the user who 
printed the job. 
 
Process – This column contains the name of the program that printed the job. 
 
Printer – This column contains the printer name or description of the printer the job was 
printed to. This corresponds, either to the desktop name of the printer, or the name of a 
Print Audit Printer if a match was found. 
 
Port – This column contains the port the printer was connected to. 
 
Paper Type – This column contains the paper type the user chose when printing the job. 
This column contains "unknown" if you do not use paper types or if the job was tracked 
without a popup. 
 
Color – This column identifies a color print job. 
 
Document – This column contains the name of the document that was printed. 
 
User-Defined One – This column contains the user-entered value for the first non-
validated user field. This column contains “unknown” if you are not using the user-
defined field, or if the job was tracked without a popup. 
 
User-Defined Two – This column contains the user-entered value for the second non-
validated user field. This column contains “unknown” if you are not using the user-
defined field or if the job was tracked without a popup. 
 
Date Printed – This column contains the date the job was printed. 
 
Paper Size – This column contains the name of the paper size used to print the job. 
 
Paper Width (In) – This column contains the width, in inches of the paper size used to 
print the job. 
 
Paper Height (In) – This column contains the height in inches of the paper size used to 
print the job. 
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Pages – This column contains the number of pages in the job. 
 
Copies – This column contains the number of copies used to print the job. Note that 
depending on the printer driver and if Collate was used, this value may be “1” even if 
more copies were printed. In this case, the number of pages is still correct. 
 
Units – This column contains the unit of measure used to calculate the job cost. 
 
Unit Cost – This column contains the cost per unit for the job. 
 
Total Units – This column contains the total units for the job. Calculated by multiplying 
pages by copies. Further calculations are done to convert the paper width and height to a 
square foot value if the unit of measure is square feet. 
 
Job Cost – This column contains the total cost of the job. Calculated by multiplying the 
unit cost by the total units. 
 
 
Print Jobs Window 
Use this window to print the current results. (For more information on printing jobs, see 
Table of Contents: Print Audit 4 User Overview: Printing Print Jobs.) 
 
Header- This field contains the header for the print job. Print Audit puts this header at 
the top of every page of the report. 
Columns List – This contains the list of all columns visible in the current search results. 
If checked, Print Audit prints the column. 
Select All Button – This button selects all of the columns in the list to print. 
Deselect All Button – This button clears all columns so none are printed. 
Print Button – Click this button to send the selected columns to the printer. 
Preview Button – Click this button to preview the column currently printing before it 
goes to the printer. 
Close Button  – Click this button to close the printing window. 
 
 
Date Formats 
This topic describes the format characters you can use when defining date formats for 
exporting data. These characters are exactly the same as those you would use for standard 
VBA date formatting. A subset of these characters appears below. 
 
M – Month, 1 digit. For example, the month of March would appear as 3. 
MM – Month, 2 digit. For example, the month of March would appear as 03. 
MMM – Month, abbreviation. For example, the month of March would appear as Mar. 
MMMM – Month, full. For example, the month of March would appear as March. 
d – Day. Follows the same rules as the M character. You can have d, dd, ddd, dddd. 
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y – Year character. You would use yy for a two-digit year or yyyy for a full four-digit 
year. 
h – Hour character. Use hh for a two-digit hour. 
m – Minute character. Use mm for two digit minutes. 
s – Second character. Use ss for two digit seconds. 
AM/PM – Use this combination to indicate you want to use a twelve-hour clock, 
otherwise a 24-hour clock is assumed. 
Other characters will appear as themselves. 
 
Here’s an example of how date formats would affect January 15, 2001 at 10:30 PM: 
 
MM/dd/yy hh:mm:ss  – would appear as 01/15/01 22:30:00. 
MMM dd, yyyy – would appear as Jan 15, 2001 
dddd, MMMM dd yyyy hh:mm AM/PM – would appear as Monday, January 15, 2001 
10:30 PM. 
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PRINT AUDIT 4 REPORTER OVERVIEW 
 
Welcome to the Print Audit Reporting tool. This tool provides you with several canned 
reports that you can view and print. The information in the reports ranges from simple 
detail records of any print jobs printed to sophisticated return on investment reports. You 
can enter parameters for each report to narrow your focus to the data you truly need. 
As well you can display some of the reports as graphs. You can print or view these 
graphs to give you a quick colorful way to view the summary data. 
 
This application only allows you to print and view preformatted reports. For flexible 
viewing and exporting of your print job data, use the Print Audit Viewer.  
 
VIEWING AND PRINTING A REPORT OVERVIEW 
 
The Print Audit Reporting tool allows you to view and print several "canned" reports. 
The tool retrieves the information from the database and displays it either as a traditional 
report or a graph. Only some reports can display as a graph. Each report allows you to 
enter some custom information through the use of report parameters. The parameters 
available vary from report to report but almost always contain a From Date and To Date. 
For more about report parameters and how they work, see Reporting Parameters. 
 
Prepared For 
The Reporting tool also allows you to specify whom the report was prepared for. For 
example if you are a reseller preparing the report for your client XYZ Corporation you 
can enter "XYZ Corporation" into the Prepared for field at the top right of the Reporting 
window. The name of the corporation displays at the top of any report you print. Print 
Audit stores the last entered “Prepared for” value so it is available the next time you start 
the Print Audit Reporting tool. 
 
Viewing a Report 

1 Click the Start->Print Audit 4->Reporter shortcut from the Windows Start Menu. 
The Print Audit Reporting window appears with all available reports listing in a box at 
the left of the window. 

2 Click the name of the report you want to view. A description of the report displays in 
the top right of the window and any available parameters list below. 

3 Enter the parameter values. These values allow you to limit the information displayed 
in the report. This becomes especially important once your Print Audit database contains 
thousands of records. 

4 Click the Show Report or the Show Graph button. The report preview window 
appears displaying the report information. Please note that you may only have the ability 
to click one of these buttons depending on the report.  

5 Click the printer button at the top of the preview window to print the report. 
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6 Close the preview window to stop viewing the report. You return to the Print Audit 
Reporting Tool window. 
 
REPORTING PARAMETERS 
Every report available in the Print Audit Reporting tool allows you to enter parameters. 
These parameters allow you to narrow the focus of your report to the information you 
require. You can leave most parameters for a report empty. This tells the Reporting tool 
to assume you are interested in all values. 
There are three different types of parameters in the Print Audit Reporting tool. They are 
date, numeric and text. 
� Date Parameters: To use date parameters, click the dropdown arrow to the 
right of the parameter to popup a small calendar. You can use this calendar to select the 
date you are interested in. 
� Numeric Parameters: To use numeric parameters, type the number you are 
interested in into the box. You do not have to enter currency symbols, but you do need to 
enter any decimal places. 
� Text Parameters: To use text parameters, type the text you are interested in 
into the box. You can enter partial text into the box and Print Audit uses that to match all 
possible values. For example you can enter "p" into the Network User parameter for the 
Print Job Detail for Network User report to pull up the print job details for all users 
whose network name starts with "p". 
 
AVAILABLE REPORTS 
The Print Audit Reporting tool currently provides you with eleven different reports. 
Below is a list of all reports available along with a short description of what the report 
provides. Click on the name of the report for detailed information including the available 
parameters. 
 
Analysis Reports 
These reports provide the total number of pages and jobs printed from users or printed to 
printers. 

� Network User Analysis – This shows the total jobs and pages printed across a date 
range broken down by network users. 

� Print Audit User Analysis – This shows the total jobs and pages printed across a 
date range broken down by Print Audit user. 

� Printer Analysis – This shows the total jobs and pages printed across a date range 
broken down by printer. 

� Printer Totals by Network User – This shows the total jobs and pages printed to 
each printer by network users. 

� Printer Totals by Print Audit User – This shows the total jobs and pages printed to 
each printer by Print Audit users. 
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Detail Reports 
These reports provide a detailed list of every job a user printed or was printed to a printer. 
The information includes the job cost as well as a final total. 

� Print Job Detail for Network User – This shows a detailed accounting of print jobs 
printed across a date range by network users. 

� Print Job Detail for Print Audit User – This shows a detailed accounting of print 
jobs printed across a date range by Print Audit users. 

� Print Job Detail for Printers – This shows a detailed accounting of print jobs 
printed to printers across a date range. 

� Print Job Detail for Validated Field – This shows a detailed accounting of print 
jobs charged to a specific validated field value across a date range. 

 
ROI Reports 
These reports provide return on investment information based on actual page totals within 
your database and estimated costs you enter as parameters. 

� Return on Investment (Cost Recovery) – This shows the potential cost recovery 
from your printing across a date range. You can enter up to three estimated 
percentages and associated costs. 

� Return on Investment (Redirection) – This shows the potential cost recovery from 
redirecting your jobs to different printers across a date range. You can enter up to 
three different job sizes for redirection as well as estimated cost values for 
redirected versus non-redirected jobs.  

 
NETWORK USER ANALYSIS REPORT 
This report provides the total number of jobs and pages network users printed across a 
date range. You can use this report to determine who the most frequent printers in your 
organization are which allows you to either have them reduce the amount of printing they 
are doing or educate them to use lower cost print devices. 
This report is similar to the Print Audit User Analysis report, the only difference being 
that this report breaks down the information using the Windows Networking login name 
rather than Print Audit’s own internal user names. 
You can display the information in this report in either a text based report format or in a 
bar chart. 
 
Available Parameters 
From date – Use this parameter to enter the starting date for information you want 
included in the report. Click the drop-down arrow to the right of this parameter to open a 
small calendar. You can use this calendar to enter the date. For example if you use the 
calendar to enter a date of "January 01, 2001" then the report will include any jobs 
printed from January 01, 2001 to the entered To date. This parameter defaults to the start 
of the current month. 
To date – Use this parameter to enter the ending date for information you want included 
in the report. Click the drop-down arrow to the right of this parameter to open a small 
calendar. You can use this calendar to enter the date. For example if you use the calendar 
Technical support can be obtained via the following: 
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to enter a date of "February 28, 2001" then the report will include any jobs printed from 
the entered From date up to and including jobs printed on February 28, 2001. This 
parameter defaults to the end of the current month. 
 
PRINT AUDIT USER ANALYSIS REPORT 
This report provides the total number of jobs and pages Print Audit users printed across a 
date range. You can use this report to determine who the most frequent printers in your 
organization are which allows you to either have them reduce the amount of printing they 
are doing or educate them to use lower cost print devices. 
This report is similar to the Network User Analysis report, the only difference being that 
this report breaks down the information using the Print Audit user rather than the 
Windows Networking login names. Please note that if you do not require users to enter 
PIN code on the Print Audit Popup window when printing jobs there will be no Print 
Audit user associated with a job. Print jobs without a Print Audit user associated with 
them show up as "Unknown" on the report. 
You can display the information in this report in either a text based report format or in a 
bar chart. 
 
Available Parameters 
From date – Use this parameter to enter the starting date for information you want 
included in the report. Click the drop-down arrow to the right of this parameter to open a 
small calendar. You can use this calendar to enter the date. For example if you use the 
calendar to enter a date of "January 01, 2001" then the report will include any jobs 
printed from January 01, 2001 to the entered To date. This parameter defaults to the start 
of the current month. 
To date – Use this parameter to enter the ending date for information you want included 
in the report. Click the drop-down arrow to the right of this parameter to open a small 
calendar. You can use this calendar to enter the date. For example if you use the calendar 
to enter a date of "February 28, 2001" then the report will include any jobs printed from 
the entered From date up to and including jobs printed on February 28, 2001. This 
parameter defaults to the end of the current month. 
 
PRINTER ANALYSIS REPORT 
This report provides the total number of jobs and pages printed to your printers across a 
date range. You can use this report to determine where most of the printing in your 
organization is going. Using this information you could get rid of printers with little or no 
traffic and educate users to send jobs to your lower cost printers. 
You can display the information in this report in either a text based report format or in a 
bar chart. 
 
Available Parameters 
From date – Use this parameter to enter the starting date for information you want 
included in the report. Click the drop-down arrow to the right of this parameter to open a 
small calendar. You can use this calendar to enter the date. For example if you use the 
calendar to enter a date of "January 01, 2001" then the report will include any jobs 
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printed from January 01, 2001 to the entered To date. This parameter defaults to the start 
of the current month. 
To date – Use this parameter to enter the ending date for information you want included 
in the report. Click the drop-down arrow to the right of this parameter to open a small 
calendar. You can use this calendar to enter the date. For example if you use the calendar 
to enter a date of "February 28, 2001" then the report will include any jobs printed from 
the entered From date up to and including jobs printed on February 28, 2001. This 
parameter defaults to the end of the current month. 
 
PRINTER TOTALS BY NETWORK USER 
This report provides the total number of jobs and pages printed to your printers across a 
date range broken down by network user. You can use this report to determine which 
printers a network user uses for most of their printing. 
This report is similar to the Printer Totals by Print Audit User report, the only difference 
being that this report breaks down the information using the Windows Networking login 
name rather than Print Audit’s own internal user names. 
You can display the information in this report in a text based report format only as there 
is no graph. 
 
Available Parameters 
From date – Use this parameter to enter the starting date for information you want 
included in the report. Click the drop-down arrow to the right of this parameter to open a 
small calendar. You can use this calendar to enter the date. For example if you use the 
calendar to enter a date of "January 01, 2001" then the report will include any jobs 
printed from January 01, 2001 to the entered To date. This parameter defaults to the start 
of the current month. 
To date – Use this parameter to enter the ending date for information you want included 
in the report. Click the drop-down arrow to the right of this parameter to open a small 
calendar. You can use this calendar to enter the date. For example if you use the calendar 
to enter a date of "February 28, 2001" then the report will include any jobs printed from 
the entered From date up to and including jobs printed on February 28, 2001. This 
parameter defaults to the end of the current month. 
User – Use this parameter to enter the full or partial name of the network user whose 
printer usage information you want to view. The report displays all network users who 
match the entered text. If you enter nothing all users are included in the report. 
 
PRINTER TOTALS BY PRINT AUDIT USER 
This report provides the total number of jobs and pages printed to your printers across a 
date range broken down by Print Audit user. You can use this report to determine which 
printers a Print Audit user uses for most of their printing. 
This report is similar to the Printer Totals by Network User report, the only difference 
being that this report breaks down the information using the Print Audit user rather than 
the Windows Networking login names. Please note that if you do not require users to 
enter PIN code on the Print Audit Popup window when printing jobs there will be no 
Print Audit user associated with a job. Print jobs without a Print Audit user associated 
with them show up as "Unknown" on the report. 

Technical support can be obtained via the following: 
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• Telephone toll free in North America 877 41 AUDIT (28348) or outside of North America 403 685-4932 (Canada) 

Page 53 



 

You can display the information in this report in a text based report format only as there 
is no graph. 
 
Available Parameters 
From date – Use this parameter to enter the starting date for information you want 
included in the report. Click the drop-down arrow to the right of this parameter to open a 
small calendar. You can use this calendar to enter the date. For example if you use the 
calendar to enter a date of "January 01, 2001" then the report will include any jobs 
printed from January 01, 2001 to the entered To date. This parameter defaults to the start 
of the current month. 
To date – Use this parameter to enter the ending date for information you want included 
in the report. Click the drop-down arrow to the right of this parameter to open a small 
calendar. You can use this calendar to enter the date. For example if you use the calendar 
to enter a date of "February 28, 2001" then the report will include any jobs printed from 
the entered From date up to and including jobs printed on February 28, 2001. This 
parameter defaults to the end of the current month. 
User – Use this parameter to enter the full or partial name of the user whose printer usage 
information you want to view. The report displays all users who match the entered text. If 
you enter nothing all users are included in the report. 
 
PRINT JOB DETAIL FOR NETWORK USER 
This report provides detailed print job information for a network user across a date range. 
The information supplied in this report includes the printer name, port, code, user defined 
fields, pages or square feet and cost. The costs are totalled at the end of the user’s 
information. Please note that this report can be extremely large if you do not use the 
parameters to limit the information returned. 
This report is similar to the Print Job Detail for Print Audit User report, the only 
difference being that this report breaks down the information using the Windows 
Networking login name rather than Print Audit’s own internal user names. 
You can display the information in this report only in a text based format. There is no 
graph available. 
 
Available Parameters 
From date – Use this parameter to enter the starting date for information you want 
included in the report. Click the drop-down arrow to the right of this parameter to open a 
small calendar. You can use this calendar to enter the date. For example if you use the 
calendar to enter a date of "January 01, 2001" then the report will include any jobs 
printed from January 01, 2001 to the entered To date. This parameter defaults to the start 
of the current month. 
To date – Use this parameter to enter the ending date for information you want included 
in the report. Click the drop-down arrow to the right of this parameter to open a small 
calendar. You can use this calendar to enter the date. For example if you use the calendar 
to enter a date of "February 28, 2001" then the report will include any jobs printed from 
the entered From date up to and including jobs printed on February 28, 2001. This 
parameter defaults to the end of the current month. 

Technical support can be obtained via the following: 
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User – Use this parameter to enter the full or partial name of the user whose detail 
information you want to view. The report displays all users who match the entered text. If 
you enter nothing all users are included in the report. 
 
PRINT JOB DETAIL FOR PRINT AUDIT USER 
This report provides detailed print job information for a Print Audit user across a date 
range. The information supplied in this report includes the printer name, port, code, user 
defined fields, pages or square feet and cost. The costs are totaled at the end of the user’s 
information. Please note that this report can be extremely large if you do not use the 
parameters to limit the information returned. 
This report is similar to the Printer Job Detail for Network User report, the only 
difference being that this report breaks down the information using the Print Audit user 
rather than the Windows Networking login names. Please note that if you do not require 
users to enter a PIN code on the Print Audit Popup window when printing jobs there will 
be no Print Audit user associated with a job. Print jobs without a Print Audit user 
associated with them show up as "None" on the report. 
You can display the information in this report only in a text based format. There is no 
graph available. 
 
Available Parameters 
From date – Use this parameter to enter the starting date for information you want 
included in the report. Click the drop-down arrow to the right of this parameter to open a 
small calendar. You can use this calendar to enter the date. For example if you use the 
calendar to enter a date of "January 01, 2001" then the report will include any jobs 
printed from January 01, 2001 to the entered To date. This parameter defaults to the start 
of the current month. 
To date – Use this parameter to enter the ending date for information you want included 
in the report. Click the drop-down arrow to the right of this parameter to open a small 
calendar. You can use this calendar to enter the date. For example if you use the calendar 
to enter a date of "February 28, 2001" then the report will include any jobs printed from 
the entered From date up to and including jobs printed on February 28, 2001. This 
parameter defaults to the end of the current month. 
User – Use this parameter to enter the full or partial name of the user whose detail 
information you want to view. The report displays all users who match the entered text. If 
you enter nothing, all users are included in the report. 
 
PRINT JOB DETAIL FOR PRINTERS 
This report provides detailed print job information for a Printer across a date range. The 
information supplied in this report includes the network user, print audit user, code, user 
defined fields, pages or square feet and cost. The costs are totaled at the end of the 
printer’s information. Please note that this report can be extremely large if you do not use 
the parameters to limit the information returned. 
You can display the information in this report only in a text based format. There is no 
graph available. 
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Available Parameters 
From date – Use this parameter to enter the starting date for information you want 
included in the report. Click the drop-down arrow to the right of this parameter to open a 
small calendar. You can use this calendar to enter the date. For example if you use the 
calendar to enter a date of "January 01, 2001" then the report will include any jobs 
printed from January 01, 2001 to the entered To date. This parameter defaults to the start 
of the current month. 
To date – Use this parameter to enter the ending date for information you want included 
in the report. Click the drop-down arrow to the right of this parameter to open a small 
calendar. You can use this calendar to enter the date. For example if you use the calendar 
to enter a date of "February 28, 2001" then the report will include any jobs printed from 
the entered From date up to and including jobs printed on February 28, 2001. This 
parameter defaults to the end of the current month. 
Printer – Use this parameter to enter the full or partial name of the printer of which 
detail information you want to view. The report displays all printers which match the 
entered text. If you enter nothing all printers are included in the report. 
 
PRINT JOB DETAIL FOR VALIDATED FIELD 
This report provides detailed print job information charged to a code across a date range. 
The information supplied in this report includes printer name, port, network user, user 
defined fields, pages or square feet and cost. The costs are totaled at the end of the codes 
information. Please note that this report can be extremely large if you do not use the 
parameters to limit the information returned. The name of the Validated field depends on 
the name you entered in the Administrator. If you are not using the Validated field feature 
you do not need this report. 
 
You can display the information in this report only in a text-based format. There is no 
graph available. 
 
Available Parameters 
From date – Use this parameter to enter the starting date for information you want 
included in the report. Click the drop-down arrow to the right of this parameter to open a 
small calendar. You can use this calendar to enter the date. For example if you use the 
calendar to enter a date of "January 01, 2001" then the report will include any jobs 
printed from January 01, 2001 to the entered To date. This parameter defaults to the start 
of the current month. 
To date – Use this parameter to enter the ending date for information you want included 
in the report. Click the drop-down arrow to the right of this parameter to open a small 
calendar. You can use this calendar to enter the date. For example if you use the calendar 
to enter a date of "February 28, 2001" then the report will include any jobs printed from 
the entered From date up to and including jobs printed on February 28, 2001. This 
parameter defaults to the end of the current month. 
Code – Use this parameter to enter the full or partial code whose detail information you 
want to view. The report displays all codes which match the entered text. If you enter 
nothing all codes are included. What this code means depends on the name you entered in 
the Administrator. 

Technical support can be obtained via the following: 
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RETURN ON INVESTMENT (COST RECOVERY) REPORT 
This report shows the estimated costs recovered if you had charged for your printing over 
the specified date range. The pie chart represents the total number of pages printed across 
the date range and each slice represents pages charged at a certain price. For more 
information see the Available Parameters section below. 
You can display this report as a graph only. There is no text-based report available. 
 
Available Parameters 
From date – Use this parameter to enter the starting date for information you want 
included in the report. Click the drop-down arrow to the right of this parameter to open a 
small calendar. You can use this calendar to enter the date. For example if you use the 
calendar to enter a date of "January 01, 2001" then the report will include any jobs 
printed from January 01, 2001 to the entered To date. This parameter defaults to the start 
of the current month. 
To date – Use this parameter to enter the ending date for information you want included 
in the report. Click the drop-down arrow to the right of this parameter to open a small 
calendar. You can use this calendar to enter the date. For example if you use the calendar 
to enter a date of "February 28, 2001" then the report will include any jobs printed from 
the entered From date up to and including jobs printed on February 28, 2001. This 
parameter defaults to the end of the current month. 
Percentage (1, 2 and 3) – Use this parameter to enter the percentage of the total pages 
for which you want to charge the associated cost. You can enter up to three different 
percentage/cost pairs. For example you could determine that you would have charged 
twenty-five cents per page for ten percent of your printing and ten cents per page for 
seventy five percent of your printing. To show the cost recovery for this scenario you 
would enter "10" in the first percentage box, "0.25" in the first cost box, "75" in the 
second percentage box and "0.10" in the second cost box. The third percentage and cost 
boxes you would leave at zero. The resulting graph would show the costs recovered if 
you had charged for the print jobs in this way. 
Cost (1, 2 and 3) – Use this parameter to enter the cost per page for the associated 
percentage. See the description of the Percentage fields above for more information on 
how to use this parameter. 
 
RETURN ON INVESTMENT (REDIRECTION) REPORT 
This report shows the estimated costs recovered if your users had printed jobs over a 
certain number of pages to lower cost devices. This report displays a bar chart with three 
bars, each one representing a different job size and costs savings. For more information 
see the Available Parameters section below. 
You can display this report as a graph only. There is no text based report available. 
 
Available Parameters 
From date – Use this parameter to enter the starting date for information you want 
included in the report. Click the drop-down arrow to the right of this parameter to open a 
small calendar. You can use this calendar to enter the date. For example if you use the 
calendar to enter a date of "January 01, 2001" then the report will include any jobs 
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printed from January 01, 2001 to the entered To date. This parameter defaults to the start 
of the current month. 
To date – Use this parameter to enter the ending date for information you want included 
in the report. Click the drop-down arrow to the right of this parameter to open a small 
calendar. You can use this calendar to enter the date. For example if you use the calendar 
to enter a date of "February 28, 2001" then the report will include any jobs printed from 
the entered From date up to and including jobs printed on February 28, 2001. This 
parameter defaults to the end of the current month. 
Page Limit (1, 2 and 3) – Use this parameter to enter the page limit or job size of jobs 
you estimate could be redirected. You can enter up to three different limits. For example 
you could determine you would want to redirect all jobs over 10 pages to another printer. 
You would enter "10" in the first page limit box and then enter your current estimated 
cost per page and the estimated cost per page if the job went to a lower cost printer. You 
can enter up to three limits to get three different scenarios of redirection. 
Estimated Cost – Use this parameter to enter the estimated cost per page before 
redirection. For example if you estimate that it costs you ten cents per page the way users 
are currently printing you would enter "0.10" in this box. 
Redirected Cost – Use this parameter to enter the cost per page if the user had redirected 
the job to a lower cost printer. For example if you estimate that it would only cost five 
cents per page to the lower cost printer you would enter "0.05" in this box.  
 

Technical support can be obtained via the following: 
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PRINT AUDIT 4 CLIENT OVERVIEW 
 
Print Audit Client allows you to intercept and store print job information coming from an 
individual’s desktop. Print Audit stores the information to a database, where you can 
report on and export the information with the Print Audit Viewer. 
Depending on settings within the Print Audit Administration tool, Print Audit pops up a 
window on the client desktop every time a normal Windows print job occurs. This 
window allows the user to enter several different pieces of information about the print job 
which Print Audit stores in the database. 
 
To run Print Audit Client: 
1 Click on the Print Audit Client icon in the Windows Start Menu. One of two things will 
occur. Either the Client starts or the Select Database window appears. 
2 If the Client icon appears in the system tray, you are done. Depending on the desktop 
settings in the Administrator the icon may not be displayed. 
OR 
3 Use the Select Database window to select the appropriate database. Contact your 
technical support people if you are not sure what this is. The Select Database window 
appears only if you have not selected a valid database previously. 
 
To shutdown the Print Audit Client: 
1 Double right-click on the Print Audit Client icon in the Windows system tray. The 
Client shuts down and the icon disappears from the tray. Depending on the Client 
Settings in the Administration utility, there may not be an icon in the tray, and you may 
not be able to shut Print Audit down. Contact your system administrator. 
 

Technical support can be obtained via the following: 
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Entering Print Job Information 

 
The main function of the Print Audit Client is to allow you to enter your specific print job 
information whenever you print from your computer. The information you enter can 
differ depending on the Print Audit Administration Popup settings. Depending on which 
printer configuration Print Audit selects or which program prints the job etc., Print Audit 
can track the job silently. This topic deals with entering information when the window 
appears. The fields and buttons that may appear on the Print Audit Client popup window 
are as follows. 
 
Printer – This read-only field contains the name of the printer used to print this job. If 
this printer matches a printer you set-up in the Administration program, then this name is 
the name you gave that printer. If there is no match, this is the name of the printer as it 
exists within Windows. 
Document – This read-only field contains the name of the document printed. This name 
comes from the program doing the printing. 
PIN Code – This field allows you to enter a PIN code. This field appears on the window 
if the Require User Validation option is checked in the Administration program. You 
must enter the PIN code for a valid user in this box for the job to be printed.  
Balance Button – This button appears to the right of the PIN Code field. It allows you to 
check any outstanding quota balance for the entered PIN code. For more information on 
quotas and users, see the Print Audit Administration help. 
Validated Value – This field allows you to enter a value that Print Audit validates 
against the database. The name of this value depends on what was entered in the Print 
Audit Administration program. Examples could be, Client or Project. You can enter 
either a code, or a description of the value. If Print Audit cannot find a match, a search 
window appears which you can use to find the proper value. This field appears on the 
window if the Use Validated Field option is checked in the Administration program. 
Search Button – This button appears to the right of the Validated Value field. You can 
click this to validate the information you entered in that field. If Print Audit cannot find a 
match, or finds multiple matches, a search window appears. 

Technical support can be obtained via the following: 
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User Defined Fields – Depending on the Popup settings, one or two fields can appear on 
the popup in the Administration program. The names of these fields are customizable. 
They are free form entry fields that must contain data. 
Paper Type – This field allows the user to select the type of paper used to print the job. 
This field only appears if paper types are defined in the Administration program and if 
they are selected for the configuration used. 
Cost – This field contains the cost per unit of the job. Print Audit displays the unit of 
measure used for the job to the right of this field. Depending on the setting of Allow Cost 
Override – In the Administration program, you can override the setting with your own 
cost. This field only appears if the Show Cost on Popup option in the Administration 
program is set. (For more on how Print Audit determines this cost, see Table of Contents: 
Print Audit 4 Administration Overview: General Settings: Allow User to Override Cost) 
Batch Size – This field appears if the Allow Job Batching option is checked in the 
Administration program. Here you can enter a number that indicates how many jobs will 
use the settings you entered on the window. Print Audit automatically cancels the batch if 
the print job comes from a different program, or is printed to a different printer. 
OK Button – This button validates the job information and allows the print job to 
continue. 
Cancel Button – This button closes the popup window and cancels the print job. Please 
note that cancelling the print job may cause error messages to popup in the program you 
are printing from. This just indicates that the job was cancelled from an outside source. 
You can safely close those pop-ups.  
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TECHNICAL SUPPORT AND CONTACT INFORMATION 
 
At Print Audit Inc. we value input from our customers.  Please feel free to contact us at 
any time. 
 
Technical support can be obtained via the following means: 
 

• Our web site http://www.printaudit.com 
• E-mail us: support@printaudit.com 
• Telephone us toll free in North America: 877 41 AUDIT (28348) [Outside of 

North America: 403 685-4932 (Canada).] 
 
For information regarding sales, pricing, and licensing please contact us via the following 
means: 
 

• E-mail: sales@printaudit.com 
• Telephone toll free in North America: 877 41 AUDIT (28348) [Outside of North 

America: 403 685-4932 (Canada).] 
 
Any other questions or comments should be directed to: 
 

• inquiry@printaudit.com 
• Our North American toll free number: 877 41 AUDIT (28348) [Outside of North 

America: 403 685-4932 (Canada).] 
 
 
Thank you for your purchase of Print Audit 4! 
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